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Data Acquisition and Processing Report
OPR-N411-NRT3-07
Tacoma, Washington
Hydrographic Letter Instructions dated February 16, 2007
Team Leader:_ Kathryn Simmons

This report includes descriptions of equipment used and methods employed by Navigation Response
Team 3 during acquisition and processing of hydrographic survey data. It does not necessarily apply to
fast-track data — a separate report will accompany data submitted directly to the Marine Chart Division.

A. EQUIPMENT

NOAA Survey Launch S1212 is used to acquire single-beam and multibeam echosounder data, side scan
sonar data, and detached positions.

Launch S1212, a 27-foot, SeaArk Commander (SAMA115510000), was acquired in January 2001. In
August 2004 the hull was extended to 30 feet to accommodate the weight of the two 150-horsepower
Yamaha four-stroke outboards which power the vessel. The launch is eight feet wide, displaces 4.8 tons,
has a static draft of 0.4 meters and is equipped with a Dell Pentium I\ PC which runs the primary
acquisition software.

Trimble DGPS systems are used to position fixed aids to navigation_and other high water features.
1. Sounding Equipment
a. Single-Beam Echosounder (SBES)

An Odom Echotrac CV vertical beam echosounder (VBES) employing a single-frequency transducer with
beam width set at eight degrees is used for single beam data collection. The echosounder, which is
operated at 200 kHz, records both analog and digital data which may be acquired in feet or meters.
Soundings are acquired in meters with an assumed speed of sound through water of 1500 m/sec. During
data collection the echosounder is controlled and the trace is monitored via an Ethernet driver connection
to the HYPACK Survey program. The echosounder trace is_ recorded to .BIN files which are logged
automatically alongside HYPACK line files during acquisition. These files are used for reference during
digital data processing.

Leadline checks are performed periodically throughout the project to verify fathometer accuracy._ A new
leadline was fabricated and calibrated on February 23, 2007.

Coastal Oceanographic’s HYPACK Max Survey Software is used for vessel navigation and line tracking
during hydrographic data acquisition. The HYPACK software is also used to log “raw” VBES data and
to record detached positions in the form of .tgt files.




b. Shallow Water Multibeam (SWMB)

In July 2006, installation of a Kongsberg Simrad EM3000 shallow water multibeam (SWMB)
echosounder was completed. The system consists of a sonar head and a processing unit. The EM3000
operates at a single-frequency of 300 kHz; it has a maximum ping rate of 40 Hz and 127 beams per ping.
Each beam has a fore-aft width of 1.5° and a port-starboard width of 1.5°+. Depth range from the sonar
head is 1 to 150+ meters, depth resolution is 1 cm and depth accuracy is 5 cm RMS. Range sampling rate
is 14 kHz.

The sonar head is fixed-mounted to the aft hull of the vessel at the keel, directly beneath inertial
measurement unit (IMU). The head contains a flat-face transducer (Mills Cross configuration) and
transmitter and receiver elements all encased in an acoustically transparent medium. The transmit beam is
steerable to compensate for mounting angle and vessel pitch.

Beam forming and bottom detection are performed by the processing unit which controls the sonar head
with respect to gain, ping rate and transmit angle. The processing unit also contains the interfaces for all
time-critical external sensors such as attitude data, position, and the pulse per second (PPS) signal.

EMS3000 controller software, operating on the HYPACK computer and communicating via Ethernet
connection, is used to control adjustable parameters such as range scale, power, gain and pulse width.
Real time sound velocity measurements are acquired by a Digibar Pro sound velocity probe mounted on
the transom and are transmitted by the controller software to the processing unit for initial beamforming

and steering.

Patch tests are performed periodically to determine residual biases of the system. The test results are
included in Appendix V.

To verify proper operation of the MBES, lead line comparison tests are performed periodically.

Coastal Oceanographic’s HYPACK Max Survey and Hysweep programs are used for vessel navigation
and line tracking, as well as swath and coverage monitoring during SWMB data acquisition. Device
parameters are monitored during acquisition with the EM3000 and POS controller software programs
operating on the HYPACK computer. MBES data are logged in the HYPACK “raw” format, with files
ending in the .HSX extension.

c. Side Scan Sonar (SSS)

The vessel is equipped with a Klein 3000 sonar system. The system includes:

Dual frequency (100 kHz, 500 kHz) towfish with 300 PSI pressure sensor
Topside Processing Unit (TPU)

Workstation Display and Control Unit (WDCU)

Thirty-five meters of Kevlar reinforced tow cable

SonarPro software and VX Works TPU operating system

The horizontal beam widths for the low and high frequencies are 1° and 2°, respectively; vertical beam
width is 40°. Maximum range scale for the Klein 3000 is 150 meters at high frequency, 500 meters at




low frequency. Only the high-frequency data are recorded and stored in the data base; the low frequency
image is monitored during data collection but not converted separately.

A range scale of 100 meters is maintained except in very deep water, when the scale is increased to 150
meters, or in very shallow water or during development of submerged obstructions, when the scale may
be reduced to 75 or 50 meters. The towfish height above the bottom is maintained at 8 to 20 percent of
the range scale whenever possible. Exceptions occur in very shallow areas or in areas where rapidly
changing terrain raises the risk of hitting the towfish on the bottom.

Side scan sonar lines are spaced according to the range scale appropriate for water depth to assure overlap
of at least 25 meters and to assure 200% coverage.

Vessel speed is maintained at or below five knots to ensure that an object one meter square could be
detected across the sonar swath. Confidence checks are performed by observing the outer edges of the
sonargram while moving alongside pier faces or known submerged targets.

All SSS data collection is controlled with SonarPro software operating in a Microsoft Windows XP
environment on the WDCU. Signals are sent to the towfish and data is received from the towfish via the
TPU. The sonar data are recorded digitally and stored on the WDCU in the Klein SDF format.

Launch S1212 is equipped with a Dynapar cable counter that logs the length of deployed towfish cable to
the WDCU via the HYPACK Delph signal. The measurements are made by counting revolutions of the
towing block on the J-frame. Before each use, the cable counter is calibrated by adjusting the readout to
reflect the measured marking on the towfish cable at the tow point.

A certification test of the system for object detection and positioning will be performed ASAP and the
results will be included in Appendix V.

d. Diver Least-Depth Gauge

Not applicable

2. Positioning and Orientation Equipment

a. Trimble DSM212L

The launch is equipped with a Trimble DSM212L integrated 12-channel GPS receiver and a dual-channel
DGPS beacon receiver. The beacon receiver can simultaneously monitor two independent U.S. Coast
Guard (USCG) DGPS beacons. There are three modes: Auto-Range, which locks onto the beacon nearest
the vessel; Auto-Power, which locks onto the beacon with the greatest signal strength; and Manual, which
allows the user to select the desired beacon. Additionally, the DSM212L can accept differential
correctors (RTCM messages) from an external source such as a user-established DGPS reference station.

The following parameters are monitored in real-time through Trimble’s TSIP Talker software to ensure
position data quality: 1) number of satellites used in the solution, 2) horizontal dilution of precision
(HDOP), 3) latency of correctors, and 4) beacon signal strength. The DSM212L is configured to the auto-
power mode, to go off-line if the age of DGPS correctors exceeds 20 seconds, and to exclude satellites
with an altitude below eight degrees.



The Trimble DSM212L supplies only DGPS correctors to the POS-MV system.

b. Applanix Position and Orientation System for_Marine Vessels (POS MV)

The POS MV includes the following components which work together to provide position and attitude
information to the data acquisition systems on S1212:

* POS MV rack mount POS Computer System (PCS)
« Inertial Measurement Unit (IMU)
» Two ldentical Trimble Zephyr GPS Antennas

The PCS contains the two GPS receivers, primary and secondary, along with interface cards to
communicate with and process the IMU and GPS data.

The primary GPS receiver is a 24-channel Trimble BD950 which receives differential (RTCM) correctors
through the PCS and provides position and velocity information. The secondary receiver provides the
information necessary to compute heading using carrier phase differential measurements between the two
receivers. Two Trimble Zephyr antennas, corresponding to the two receiver cards, are mounted 1.90
meters apart atop the launch cabin. The port side antenna is the primary antenna.

The IMU comprises three solid-state linear accelerometers and three solid state gyros which work
together with electronics to provide digital measurements of acceleration in three directions and motion
measurements around all three axes of the IMU.

The POS MV is operated and monitored with the POS MV Controller software operating on the
HYPACK computer and sends position and orientation data through the Simrad EM3000 processing unit
to the HYPACK data files.

Tables listing data acquisition hardware and software are included in Appendix I.

B. DATA PROCESSING AND QUALITY CONTROL
1. SBES and SWMB Data

Both SBES and SWMB raw data are converted from HYPACK to the CARIS HDCS format using the
CARIS HIPS conversion wizard. Navigation and attitude data are examined using CARIS HIPS attitude
and navigation editors. Evident fliers are rejected and the track line between good navigation points is
either interpolated or rejected. The digital SBES depths are compared with the trace recorded in the
echosounder .Bin files. The digital record is edited when warranted to ensure that peaks of shoals and
abrupt changes in slope are properly depicted.  SWMB swath data are examined and edited when
necessary in Subset Editor and in Swath Editor.

Corrections to soundings (see Section C below) are applied during the final merge process in HIPS.

2. Side Scan Sonar (SSS) Data

Raw SSS data are also converted to the CARIS HDCS format using the CARIS HIPS conversion wizard
and then reviewed with the attitude and navigation editors in the same manner as the sounding data. The
CARIS Sensor Layout tool is used to examine the values of the active sensors, cleaning where necessary.



Towfish navigation is recomputed, bottom tracking (fish height) is corrected if necessary, and the
sonargram is slant-range corrected. The sonargram is then examined for significant contacts (shadow
height of 1.0 meter or greater). Contacts selected for development are exported to Mapinfo, where the
HydroMI program is used to generate HYPACK target and line files. Assurance that adequate side scan
coverage has been acquired is achieved through the generation of mosaics in a CARIS field sheet — one
mosaic for the first 100% and one for the second 100%.

3. Processing Software

CARIS HIPS and SIPS software is used to convert, edit and analyze all sounding and side scan data and
to apply vertical and horizontal correctors,

NOAA'’s Pydro software supplied by the Hydrographic Systems and Technology Program (HSTP) is used
for analyzing sounding data and SSS contacts, for processing and editing detached positions, and for
decimating data in the creation of preliminary smooth sheet (PSS) files.

HSTP’s HydroMI Mapbasic program is used in combination with Mapinfo software for a number of Pre
and Post-Survey applications.

HSTP’s VelocWin program is used to process sound velocity data obtained with Seacat SBE-19 and SBE
19 Plus CTD’s and an Odom Digibar profiler.

4. Data Decimation and Field Sheet Production

If required to maintain manageable base surfaces sizes, the survey area is broken into multiple
overlapping CARIS field sheets. See Section B4 in the Descriptive Report for this survey.

Weighted Grid Data are inserted into a Pydro Preliminary Smooth Sheet (PSS). Final Mapinfo data plots
are created with the HydroMI Mapbasic tool.

Tables listing data processing hardware and software are included in Appendix I.

Data processing flow diagrams are included in Appendix II.

C. CORRECTIONS TO ECHO SOUNDINGS
1. Sound Velocity

The speed of sound through the water is determined by sound velocity casts conducted in accordance with
the NOS Hydrographic Surveys Specifications and Deliverables (HSSD) Manual

Corrections for speed of sound through the water column are computed from data obtained with an SBE-
19 Seacat, and SBE-19 Plus CTD. NOAA'’s VelocWin software is used to process casts and generate
sound velocity files for CARIS HIPS. Sound velocity correctors are applied to sounding data in CARIS
HIPS using the “nearest in distance within_time” sound velocity cast.

Calibration reports for the Odom Digibar, SBE-19 Seacat, and SBE-19 Seacat Plus are included in
Appendix 1V of this report. Dates and locations of the sound velocity casts are included in Separate 11 of
the survey descriptive report.



| 2. Vessel Offsets, Dynamic Draft, and True Heave Correctors

a. Static Draft

New static draft measurements for the multibeam and single beam transducers were calculated on August
16, 2006 (DN 228) employing the following procedure.

| First, the depth of each transducer face from the top of the blue paint line above the respective transducer
was measured. Next, with the launch in the water, fuel tanks half full and two persons aboard, the
distance from this reference mark to the waterline was measured. By subtracting the second measurement
from the first a static draft of 0.5 meters was calculated for the SWMB transducer and 0.3 meters for the
single beam transducer.

b. Dynamic Draft

New dynamic draft measurements were calculated on August 16, 2006 (DN 228), using the single beam
echosounder and the method described in FPM 1.4.2.1. Data for the measurements were acquired over a
region selected for minimum cross-track error.

Offsets measured from the reference point to the transducer, sensors and antenna were, together with
static and dynamic draft correctors, incorporated into the ‘vessel config’ files and applied during the
| merge process in CARIS. Offset diagrams and CARIS vessel config files are included in Appendix I11.

c. TPE

Measured sound speed TPE for OPR-N411-NRT3-07 were entered in CARIS as 4 m/s. This
number is based on frequency of casts (one cast every four hours) acquired during data acquisition.
Surface sound speed values were entered in CARIS as 0.2 m/s. Tide zoning uncertainty values were
provided by CO-OPS in the project instructions and divided by 2 to approximate the required 1
sigma error level.

d. True Heave

During data collection, true heave corrections were logged through the POS MV Controller to a separate
data file and applied to the hydro data during post-processing.

3. Tide Correctors

The operating National Water Level Observation Network (NWLON) station at Tacoma, WA (944-6484)
served as datum control for the survey area.

Verified, six-minute water levels relative to Mean Lower Low Water were downloaded from the NOAA,
NOS, Center for Operational Oceanographic Products and Services (CO-OPS) web site:

| (http://tidesandcurrents.noaa.gov/olddata). These were imported into a text file on a local computer and
appended to the CARIS tide file, 9446484.tid.




There are three tide zones within the project limits. Time and range correctors, referenced to the tide
station at Tacoma, WA, are provided in the zoning file N411NRT32007CORP.zdf which is included with
the project data.

Using the CARIS HIPS Load Tide process, soundings are sorted into the appropriate tide zone; time and
range adjustments are computed and applied to the verified tides in each zone.

All correctors are finally applied to the data using the CARIS “Merge” utility. The corrected depths are
then_used by Pydro for the generation of preliminary smooth sheets (PSS).

D. APPROVAL

As Chief of Party, | have ensured that standard field surveying and processing procedures were used
during this project in accordance with the Hydrographic Manual, Fourth Edition; Hydrographic Survey
Guidelines; Field Procedures Manual, and the NOS Hydrographic Surveys Specifications and
Deliverables Manual.

I acknowledge that all of the information contained in this report is complete and accurate to the best of
my knowledge.

Approved and Forwarded:

Kathryn Simmons
Navigation Response Team 3
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APPENDICES

APPENDIX |
Software Versions and Hardware Serial Numbers

In-service date Software Version
Acquisition
05/18/2007 6.2a
03/18/2008 Hypack Max 6.2b
05/01/2008 2008
07/14/2005 Klein 3000 Sonar Pro 9.6
08/01/2006 TSIP Talker 2.0
08/01/2006 POS MV Controller 3.3.01
08/01/2006 EM3000 Controller 1.0.91
08/01/2006 Echotrac Control Software 3.08
Processing
05/07/2007 7.3.0
06/15/2008 Pydro 8.6
08/08/2008 8.7
08/01/2006 KapConv 573
08/01/2006 8.5
09/24/2007 Maplinfo 9.0
10/15/2008 9.5
10/24/2006 6.8.1
01/29/2007 HydroM| 6.10.2
08/01/2006 Vertical Mapper 2.0
02/12/2007 6.1
07/16/2007 Caris HIPS/SIPS 6.1, SP1
07/17/2008 6.1, SP2
03/03/2004 CARIS GIS 4.4a
07/19/2007 Nobeltec Tides & Currents 3.5.107
Sound Velocity

05/21/2007 VelocWin 8.86
03/31/2005 Digibar Pro Log 2.3
05/01/2007 Sea Term 1.57




In-service

date Equipment Serial Number
Survey Launch 1212
03/03/2004 Klein 3000 Dual Frequency Towfish (Model 3210) 456
03/03/2004 Klein 3000 TPU 312
03/03/2004 Klein 3000 Workstation 22-291
03/03/2004 Trimble DSM212L 0220164491
03/03/2004 Trimble Antenna 0220330095
03/03/2004 Dynapar Max Count Cable Counter N/A
03/31/2005 Odom Digibar Pro DB-200 Controller 98308
08/01/2007 Odom Digibar Pro DB-200 Probe 98314
05/18/2007
through
08/01/2007 Odom Digibar Pro DB-200 Probe 98206
10/24/2005 Odom ETCVX2 (Echotrac CV) 23015
08/01/2006 to
04/22/2008 POS MV Controller 2245
04/23/2008 to
09/29/2008 POS MV Controller 2254
12/08/2008 to
12/14/2008 POS MV Controller A009170
08/01/2006 POS MV IMU Unknown
. Port 60080830
08/01/2006 Trimble Zephyr Antennas Stbd 60069001
08/01/2006 Simrad EM 3000 Multibeam Sonar 358
. 1534
08/01/2006 Simrad EM 3000 Controller Dongle 040131
08/01/2006 New Hypack Computer from PHB B7F8MA41
09/05/2006 SBE 19 Seacat 1913768-2039
10/10/2006 SBE 19 Plus Seacat 19P44126-4778
NRT3 Office
08/01/2006 NRT3-1 Data Processing CPU 9VQLKB1
08/01/2006 NRT3-2 Data Processing CPU BVQLKB1
08/01/2006 NRT3-3 Data Processing CPU H5TYT61
10/01/2008 NRT Data Processing CPU 1K5N2H1
Trimble Backpack Units
07/26/2006 Pro XRS 12 Channel DGPS Receiver #1 SN 0224062536 / PN 33302-51
07/26/2006 Combined L1 GPS/Beacon/Satellite Differential Antenna #1 | SN 0220284591 / PN 33580-50
07/26/2006 Trimble TSC1 Datalogger #1 SN 0220262979 / PN 29673-50
07/26/2006 Pro XRS 12 Channel DGPS Receiver #2 SN 0224024875 / PN 33302-51
07/26/2006 Combined L1 GPS/Beacon/Satellite Differential Antenna #2 | SN 0220257168 / PN 33580-50
07/26/2006 Trimble TSC1 Datalogger #2 SN 0220276706 / PN 29673-50
07/26/2006 GeoXT 12 Channel GPS Receiver/Handheld SN 4428E01847 / PN 50950-20

07/26/2006

Beacon-on-a-Belt Differential Receiver/Antenna

SN 0440111069 / PN 38508-00
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Processing Flow Diagrams



Raw SSS/Hypack Data to Pydro

S1212 SSS SDF Data <
SBES/SWMB Hvpoack Raw Data

A 4

Conversion using CARIS
HIPS Conversion Wizard

Digibar data Seacat data l
l l HDCS Data
Download with Download with
Diaibar Pro VelocWin l

Check/clean attitude and
naviaation

Process with
VelocWin

S19eU02 B)eBISaAU|

SSS or

CARIS Echosounder Echosounder SSS
.SVP files Data?
SBES or
SBES SWMB? SWMB
l A 4
Download & Clean depths in Recompute towfish
format tides SB Editor Load true heave navigation
from CO-OPS
website l
»  SVP correct - -
v | Clean fish height |
CARIS / _ l
.TID files > Load tides
| Slant range correct |
Select and export
CARIS vessel contacts
confia
Fieldsheet and
BASE surface
A
Line/BASE A
Insertinto 1  cleaningis Clean depths in Subset and
Pvdro PSS finished h Swath Editors




Caris Data to Mapinfo Plot

Open PSS

in Pydro

Y
Set PSS parameters:
Bathymetry Grid
Resolution (meters): 15

Y

Set Plot Configuration
Over-Plot Removal
Character Size: -
Feature Symbol Size: 18
Bathymetry Font Size: 18

Y
Insert Caris Line Bathy
from HDCS Data

l Save PSS |

Y
Start Mapinfo:
Draw Preliminary
Smooth Sheet

/ Oﬂxxx_PSSFEATURF_/ FOOxxx_PSSBATHY / /UOXXX_PSSMEIE Data

Y
| DP's | Contour using
l plotting_fathoms
[ FOOxxx_Features | Y

use Vertical Mapper
to create table
FOOxxx_Contours
based on HSG69

/ All tables and
»/ workspace in folder /€

»
/ FOOxxx_Final_Plots

apinfo data
submission

DP Depths
plot plot




Detached Position Processing

Detached
Positions
(.tgt file)

Insert into
Pydro

!

Select Project

!

Select Vessel
(DPES or non-ES)

Save PSS |—/ CARIS line file /
created

|

Open line files
in CARIS

|

YES
Apply Sound Velocity NO
Correction l
Apply tides Apply tides

|

Update Pydro PSS

|

See
"Detached
position
processing in
Pydro"




Detached

NO

Position processing in Pydro

Inserted
Pydro
Features

Is Feature the "Primary" contact on a physical object?
1. Best DP on a shoreline feature?

Primary? 2. Best SSS Image?
3. SWMB or VBES Least Depth?
4.

Dive Investigation DP?

1. Select best feature on object
and designate as "Primary".

2. Designate Correlating
Contacts "Secondary".

YES
v

1. Designate as "Primary".
2. Designate Correlating

Features "Secondary".
[

Does the feature meet the standard of "Significance"?
1. DP corresponds to significant feature?
2. SSS Contact Height >1m or 20% of water depth in >20m of water?

Mark "Resolved" NO 3. SSS Contact poses particular hazard to navigation?
4. SSS Contact of possible cultural or historical significance?

5. Bathy or Dive DP on significant feature?

VES 6. Shoal sounding on "skin of the earth" type feature?
v

1. Mark "Significant".
2. Assess Bathy Coverage.

1. Mark "Investigate”, clear
"Tgt Exported"” flag if set.
2. Export Investigation ltems
(sets "Tgt Exported").
3. Plan and execute additional
coverage (SWMB, VBES,
DI, DP)

Is additional investigation required?

1. Nadir, or near-nadir bathymetry coverage?

2. Suspicious sounding or DP?

3. Diver Investigation required to identify object?

4——YES Investigate?

NO

v
1. Clear "Investigate"
2. Select new "Primary"
3. Describe Investigation

in "Remarks"
Chart? Does the Hydrographer recommend plotting this feature on the
’ Smooth Sheet? (includes features representing disproval DPs)
NO
YES
h 4
1. Mark "Chart" and select Feature Type.
2. Make Charting Recomendation.
Mark "Report" «4—YES Report? Will feature be specifically addressed in Descriptive Report?
NO
1. Mark "DTON".
Mark "Resolved" 4——NO YES——>» 2. Generate DTON Report.
3. Mark "Resolved".
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Vessel Offsets
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CARIS HIPS Vessel Configuration Files

S1212 SBES HIPS Vessel File
Vessel Name: 1212sb.hvf
Vessel created: August 15, 2006

Depth Sensor:

Sensor Class: Swath

Time Stamp: 2004-274 00:00
Transduer #1:

Pitch Offset: 0.000

Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model: Unknown
Serial Number:

Depth Sensor:

Sensor Class: Swath

Time Stamp: 2006-103 00:00
Transduer #1:

Pitch Offset: 0.000

Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model: Unknown
Serial Number:

Depth Sensor:

Sensor Class: Swath

Time Stamp: 2006-228 00:00
Transduer #1:

Pitch Offset: 0.000

Roll Offset: 0.000



Azimuth Offset: 0.000

DeltaX:
DeltaY:
DeltaZ:

-0.173
2.118
0.419

Manufacturer: Odom

Model:

Unknown

Serial Number: Echotrac CV--23015

Navigation Sensor:

Time Stamp: 2004-274 00:00

Comments

Latency 0.000

DeltaX:
DeltaY:
DeltaZ:

0.170
-0.720
-3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2006-103 00:00

Comments
Latency 0.000
DeltaX: 0.170
DeltaY: -0.720
DeltaZ: -3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2006-228 00:00

Comments RP to IMU
Latency 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Trimble/Applanix
Model: Zephyr/POSMV4
Serial Number:

Gyro Sensor:

Time Stamp: 2004-274 00:00



Comments

Latency 0.000

Time Stamp: 2006-103 00:00
Comments

Latency 0.000

Time Stamp: 2006-228 00:00

Comments
Latency 0.000

Heave Sensor:
Time Stamp: 2006-228 00:00

Comments
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
Deltaz: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:

Pitch Sensor:
Time Stamp: 2006-228 00:00

Comments

Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:

Roll Sensor:
Time Stamp: 2006-228 00:00
Comments
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: Applanix



Model:
Serial Number:

POSMV4

Draft Sensor:
Time Stamp:

Apply Yes

Comments

Entry 1) Draft:
Entry 2) Draft:
Entry 3) Draft:
Entry 4) Draft:
Entry 5) Draft:
Entry 6) Draft:
Entry 7) Draft:
Entry 8) Draft:
Entry 9) Draft:
Entry 10) Draft
Entry 11) Draft
Entry 12) Draft

Entry 13) Draft:
Entry 14) Draft:
Entry 15) Draft:
Entry 16) Draft:
Entry 17) Draft:

Time Stamp:

Apply Yes

Comments

Entry 1) Draft
Entry 2) Draft
Entry 3) Draft
Entry 4) Draft
Entry 5) Draft
Entry 6) Draft
Entry 7) Draft
Entry 8) Draft
Entry 9) Draft
Entry 10) Draft
Entry 11) Draft
Entry 12) Draft

Entry 13) Draft:
Entry 14) Draft:
Entry 15) Draft:
Entry 16) Draft:
Entry 17) Draft:

Time Stamp:

Apply Yes
Comments
Entry 1) Draft:

Entry 2) Draft: -0.003

2004-274 00:00

0.000 Speed:
0.045 Speed:
0.099 Speed:
0.149 Speed:
0.128 Speed:
0.117 Speed:
0.098 Speed:
0.091 Speed:
0.079 Speed:
:0.043 Speed:
1 0.029 Speed:
:0.025 Speed:

-0.023 Speed:

-0.063 Speed:

-0.058 Speed:

-0.073 Speed:

-0.044 Speed:

2006-103 00:00

0.000 Speed:
0.045 Speed:
0.099 Speed:
0.149 Speed:
0.128 Speed:
0.117 Speed:
0.098 Speed:
0.091 Speed:
0.079 Speed:
:0.043 Speed:
1 0.029 Speed:
:0.025 Speed:

-0.023 Speed:

-0.063 Speed:

-0.058 Speed:

-0.073 Speed:

-0.044 Speed:

0.000

2006-228 00:00

3.100
4.900
5.500
6.300
7.000
7.600
8.100
8.300
8.700
9.400
10.100
10.800
11.800
12.900
13.800
15.000
15.800

3.100
4.900
5.499
6.300
7.000
7.600
8.100
8.300
8.701
9.400
10.100
10.800
11.799
12.899
13.799
15.001
15.800

Speed: 4.599

Speed:

5.171



Entry 3) Draft: 0.029 Speed: 5.853

Entry 4) Draft: 0.028 Speed: 6.685
Entry 5) Draft: 0.044 Speed: 7.361
Entry 6) Draft: 0.014 Speed: 8.013
Entry 7) Draft: 0.032 Speed: 8.421
Entry 8) Draft: -0.013 Speed: 9.251
Entry 9) Draft: -0.064 Speed: 10.503

Entry 10) Draft: -0.048 Speed: 11.848
Entry 11) Draft: -0.140 Speed: 14.153

TPE
Time Stamp: 2004-274 00:00

Comments
Offsets

Motion sensing unit to the transducer 1
X Head 1 0.000
Y Head 1 0.000
Z Head 1 0.000

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1-0.170
Y Head 1 0.720
Z Head 1 3.940

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.000 or 0.000" of heave amplitude.
Measurement errors: 0.020

Motion sensing unit alignment errors
Gyro:0.000 Pitch:0.000 Roll:0.000

Gyro measurement error: 0.000

Roll measurement error: 0.000

Pitch measurement error: 0.000

Navigation measurement error: 0.000
Transducer timing error: 0.000

Navigation timing error: 0.100

Gyro timing error: 0.000

Heave timing error: 0.000

PitchTimingStdDev: 0.000

Roll timing error: 0.000

Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000

Tide zoning error: 0.000

Speed over ground measurement error: 0.030



Dynamic loading measurement error: 0.030
Static draft measurement error: 0.050
Delta draft measurement error: 0.010

Time Stamp: 2006-228 00:00

Comments
Offsets

Motion sensing unit to the transducer 1
X Head 1-0.173
Y Head 1 2.118
Z Head 1 0.419

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1-0.173
Y Head 1 2.118
Z Head 1 0.419

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.020

Motion sensing unit alignment errors
Gyro:1.000 Pitch:1.000 Roll:1.000

Gyro measurement error: 0.020

Roll measurement error: 0.020

Pitch measurement error: 0.020

Navigation measurement error: 0.700
Transducer timing error: 0.010

Navigation timing error: 0.001

Gyro timing error: 0.001

Heave timing error: 0.001

PitchTimingStdDev: 0.001

Roll timing error: 0.001

Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000

Tide zoning error: 0.000

Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.030
Static draft measurement error: 0.050

Delta draft measurement error: 0.010

Svp Sensor:

Time Stamp: 2004-274 00:00



Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: -0.173

0.000

0.000

0.000

0.000

2006-103 00:00

0.000

0.000

0.000

0.000

2006-228 00:00

0.000

0.000



DeltaY: 2.118
DeltaZ: 0.419

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

0.000

0.000

WaterLine:
Time Stamp:
Comments
Apply Yes
WaterLine -0.400
Time Stamp:
Comments
Apply Yes
WaterLine -0.400

Time Stamp:

2004-274 00:00

2006-103 00:00

2006-228 00:00

Comments RP to ""'mean water level™ as surveyed

Apply Yes
WaterLine 0.022

S1212 SSS HIPS Vessel File
Vessel Name: S1212sss_100.hvf
Vessel created: September 14, 2006

Depth Sensor:

Sensor Class:
Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:

Swath
2002-084 00:00

0.000

0.000



Model:
Serial Number:

Depth Sensor:

Sensor Class:
Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000
Manufacturer:
Model:

Serial Number:
Depth Sensor:

Sensor Class:
Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
Deltaz: 0.000
Manufacturer:
Model:

Serial Number:
Depth Sensor:

Sensor Class:
Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Unknown

Swath
2004-147 00:00

0.000

0.000

Unknown

Swath
2004-274 00:00

0.000

0.000

Unknown

Swath
2006-103 00:00

0.000

0.000



Manufacturer:
Model: Unknown
Serial Number:

Depth Sensor:

Sensor Class: Swath

Time Stamp: 2006-228 00:00
Transduer #1:

Pitch Offset: 0.000

Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -0.173
DeltaY: 2.118
DeltaZ: 0.419

Manufacturer: Odom
Model: Unknown
Serial Number: Echotrac CV--23015

Navigation Sensor:
Time Stamp: 2002-084 00:00

Comments
Latency 0.000
DeltaX: 0.170
DeltaY: -0.720
DeltaZ: -3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2004-147 00:00

Comments
Latency 0.000
DeltaX: 0.170
DeltaY: -0.720
DeltaZ: -3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2004-274 00:00

Comments
Latency 0.000



DeltaX: 0.170
DeltaY: -0.720
DeltaZ: -3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2006-103 00:00

Comments
Latency 0.000
DeltaX: 0.170
DeltaY: -0.720
Deltaz: -3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2006-228 00:00

Comments RP to IMU
Latency 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Trimble/Applanix
Model: Zephyr/POSMV4
Serial Number:

Gyro Sensor:

Time Stamp: 2002-084 00:00
Comments

Latency 0.000

Entry 0) Draft: 0.000 Speed: 0.000
Time Stamp: 2004-147 00:00
Comments

Latency 0.000

Entry 0) Draft: 0.000 Speed: 0.000
Time Stamp: 2004-274 00:00
Comments

Latency 0.000



Time Stamp: 2006-103 00:00
Comments

Latency 0.000

Time Stamp: 2006-228 00:00

Comments
Latency 0.000

Heave Sensor:
Time Stamp: 2006-228 00:00

Comments
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:

Pitch Sensor:
Time Stamp: 2006-228 00:00

Comments

Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:

Roll Sensor:
Time Stamp: 2006-228 00:00

Comments
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:



Draft Sensor:

Time Stamp: 2002-084 00:00
Apply Yes

Comments

Entry 1) Draft: 0.000 Speed: 5.300
Entry 2) Draft: -0.100 Speed: 5.400
Entry 3) Draft: -0.200 Speed: 7.500
Entry 4) Draft: -0.300 Speed: 20.000
Time Stamp: 2004-147 00:00
Apply Yes

Comments

Entry 1) Draft: 0.017 Speed: 4.600
Entry 2) Draft: 0.000 Speed: 5.500
Entry 3) Draft: 0.032 Speed: 5.900
Entry 4) Draft: 0.026 Speed: 6.700
Entry 5) Draft: 0.041 Speed: 7.200
Entry 6) Draft: 0.110 Speed: 7.700
Entry 7) Draft: 0.007 Speed: 7.800
Entry 8) Draft: 0.020 Speed: 8.300
Entry 9) Draft: 0.011 Speed: 9.200
Entry 10) Draft: 0.030 Speed: 10.000
Entry 11) Draft: 0.010 Speed: 11.900

Entry 12) Draft: -0.012 Speed: 13.900
Entry 13) Draft: -0.047 Speed: 20.200

Time Stamp: 2004-274 00:00
Apply Yes

Comments

Entry 1) Draft: 0.000 Speed: 3.100
Entry 2) Draft: 0.045 Speed: 4.900
Entry 3) Draft: 0.099 Speed: 5.500
Entry 4) Draft: 0.149 Speed: 6.300
Entry 5) Draft: 0.128 Speed: 7.000
Entry 6) Draft: 0.117 Speed: 7.600
Entry 7) Draft: 0.098 Speed: 8.100
Entry 8) Draft: 0.091 Speed: 8.300
Entry 9) Draft: 0.079 Speed: 8.700
Entry 10) Draft: 0.043 Speed: 9.400
Entry 11) Draft: 0.029 Speed: 10.100
Entry 12) Draft: 0.025 Speed: 10.800

Entry 13) Draft: -0.023 Speed: 11.800
Entry 14) Draft: -0.063 Speed: 12.900
Entry 15) Draft: -0.058 Speed: 13.800
Entry 16) Draft: -0.073 Speed: 15.000
Entry 17) Draft: -0.044 Speed: 15.800

Time Stamp: 2006-103 00:00

Apply Yes
Comments



Entry 1) Draft:
Entry 2) Draft:
Entry 3) Draft:
Entry 4) Draft:
Entry 5) Draft:
Entry 6) Draft:
Entry 7) Draft:
Entry 8) Draft:
Entry 9) Draft:
Entry 10) Draft
Entry 11) Draft
Entry 12) Draft

Entry 13) Draft:
Entry 14) Draft:
Entry 15) Draft:
Entry 16) Draft:
Entry 17) Draft:

Time Stamp:

Apply Yes
Comments

0.000 Speed:
0.045 Speed:
0.099 Speed:
0.149 Speed:
0.128 Speed:
0.117 Speed:
0.098 Speed:
0.091 Speed:
0.079 Speed:
:0.043 Speed:
1 0.029 Speed:
:0.025 Speed:

-0.023 Speed:

-0.063 Speed:

-0.058 Speed:

-0.073 Speed:

-0.044 Speed:

2006-228 00:00

3.100
4.900
5.499
6.300
7.000
7.600
8.100
8.300
8.701
9.400
10.100
10.800
11.799
12.899
13.799
15.001
15.800

4.599
5.171
5.853
6.685
7.361
8.013
8.421
9.251
10.503
11.848
14.153

Entry 1) Draft: 0.000 Speed:

Entry 2) Draft: -0.003 Speed:

Entry 3) Draft: 0.029 Speed:

Entry 4) Draft: 0.028 Speed:

Entry 5) Draft: 0.044 Speed:

Entry 6) Draft: 0.014 Speed:

Entry 7) Draft: 0.032 Speed:

Entry 8) Draft: -0.013 Speed:

Entry 9) Draft: -0.064 Speed:

Entry 10) Draft: -0.048 Speed:

Entry 11) Draft: -0.140 Speed:
Tow Point:

Time Stamp: 2002-084 00:00

Comments

Latency 0.000

DeltaX: 0.760

DeltaY: -4.200

DeltaZ: -2.800

Manufacturer:

Model:

Serial Number:

Time Stamp:

Comments
Latency 0.000
DeltaX:
DeltaY:
DeltaZ:

-4.2
-2.8

2004-147 00:00

0.760

00
00



Manufacturer:
Model:
Serial Number:

Time Stamp:

Comments
Latency 0.000
DeltaX:
DeltaY:
DeltaZ:

Manufacturer:
Model:
Serial Number:

Time Stamp:

Comments
Latency 0.000
DeltaX:
DeltaY:
Deltaz:

Manufacturer:
Model:
Serial Number:

Time Stamp:

Comments
Latency 0.000

DeltaX: 0.646
DeltaY:
Deltaz:

Manufacturer:
Model:
Serial Number:

0.760
-4.200
-2.800

0.760
-4.200
-2.800

-2.174
-2.567

2004-274 00:00

2006-103 00:00

2006-228 00:00

Svp Sensor:
Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

2002-084 00:00

0.000

0.000



DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset:
Roll Offset: 0.000

0.000

0.000

2004-147 00:00

0.000

0.000

0.000

0.000

2004-274 00:00

0.000

0.000

0.000



Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: -0.173

DeltaY: 2.118
DeltaZ: 0.419

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

0.000

2006-103 00:00

0.000

0.000

0.000

0.000

2006-228 00:00

0.000

0.000

0.000

0.000

WaterLine:



Time Stamp: 2002-084 00:00

Comments
Apply Yes
WaterLine -0.400

Time Stamp: 2004-147 00:00
Comments

Apply Yes

WaterLine -0.400

Time Stamp: 2004-274 00:00
Comments

Apply Yes

WaterLine -0.400

Time Stamp: 2006-103 00:00
Comments

Apply Yes

WaterLine -0.400

Time Stamp: 2006-228 00:00
Comments RP to ""'mean water level" as surveyed

Apply Yes
WaterLine 0.022

S1212 SSS HIPS Vessel File (Used to convert data with timestamp

error. See Descriptive Report for details)
Vessel Name: S1212sss_100_time.hvf
Vessel created: May 21, 2008

Depth Sensor:

Sensor Class: Swath

Time Stamp: 1999-230 00:00
Transduer #1:

Pitch Offset: 0.000

Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -0.173
DeltaY: 2.118
DeltaZ: 0.419

Manufacturer: Odom
Model: Unknown



Serial Number: Echotrac CV--23015

Navigation Sensor:
Time Stamp: 1999-230 00:00

Comments RP to IMU
Latency 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Trimble/Applanix
Model: Zephyr/POSMV4
Serial Number:

Gyro Sensor:

Time Stamp: 1999-230 00:00
Comments

Latency 0.000

Entry 0) Draft: 0.000 Speed: 0.000

Heave Sensor:
Time Stamp: 1999-230 00:00

Comments
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
Deltaz: 0.000
Offset: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:

Pitch Sensor:
Time Stamp: 1999-230 00:00

Comments

Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: Applanix
Model: POSMV4
Serial Number:



Roll Sensor:
Time Stamp:

Comments
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer:
Model:
Serial Number:

1999-230 00:00

Applanix
POSMV4

Draft Sensor:
Time Stamp:

Apply Yes

Comments

Entry 1) Draft: 0.000
Entry 2) Draft: -0.003
Entry 3) Draft: 0.029
Entry 4) Draft: 0.028
Entry 5) Draft: 0.044
Entry 6) Draft: 0.014
Entry 7) Draft: 0.032
Entry 8) Draft: -0.013
Entry 9) Draft: -0.064
Entry 10) Draft: -0.048
Entry 11) Draft: -0.140

1999-230 00:00

Speed: 4.599
Speed: 5.171
Speed: 5.853
Speed: 6.685
Speed: 7.361
Speed: 8.013
Speed: 8.421
Speed: 9.251
Speed: 10.503
Speed: 11.848
Speed: 14.153

Tow Point:
Time Stamp:

Comments
Latency 0.000
DeltaX: 0.646
DeltaY: -2.174
DeltaZ: -2.567

Manufacturer:
Model:
Serial Number:

1999-230 00:00

Svp Sensor:
Time Stamp:
Comments

Svp #1:

1999-230 00:00



Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -0.173
DeltaY: 2.118
DeltaZ: 0.419

Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

WaterLine:
Time Stamp: 1999-230 00:00
Comments RP to ""'mean water level™ as surveyed

Apply Yes
WaterLine 0.020

S1212 SWMB HIPS Vessel File
Vessel Name: S1212_Simrad.hvf
Vessel created: July 17, 2007

Depth Sensor:

Sensor Class: Swath

Time Stamp: 2006-234 00:00
Transduer #1:

Pitch Offset: 0.000

Roll Offset: -0.060
Azimuth Offset: 0.000

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631
Manufacturer: Kongsberg
Model: em3000
Serial Number:

Depth Sensor:

Sensor Class: Swath



Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: -0.060
Azimuth Offset:

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631
Manufacturer:
Model:

Serial Number:

2008-114 00:00

0.000

0.000

Kongsberg
em3000

Navigation Sensor:
Time Stamp:

Comments RP
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:
Serial Number:

2006-234 00:00

Applanix
POS/MV4
(null)

Gyro Sensor:
Time Stamp:

Comments (null)
Latency 0.000

2006-234 00:00

Heave Sensor:
Time Stamp:

Comments (null)
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
Deltaz: 0.000
Offset: 0.000

Manufacturer:
Model:
Serial Number:

2006-234 00:00

Applanix
POS/MV4
(null)



Pitch Sensor:
Time Stamp:

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer:
Model:
Serial Number:

2006-234 00:00

Applanix
POS/MV4
(null)

Roll Sensor:
Time Stamp:

Comments (null)
Apply Yes
Latency 0.000
Roll offset: 0.000

Manufacturer:
Model:
Serial Number:

2006-234 00:00

Applanix
POS/MV4
(null)

Draft Sensor:
Time Stamp:

Apply Yes
Comments (null)

2006-234 00:00

Entry 1) Draft: 0.000
Entry 2) Draft: -0.003
Entry 3) Draft: 0.029
Entry 4) Draft: 0.028
Entry 5) Draft: 0.044
Entry 6) Draft: 0.014
Entry 7) Draft: 0.032
Entry 8) Draft: -0.013
Entry 9) Draft: -0.064
Entry 10) Draft: -0.048
Entry 11) Draft: -0.140

Speed: 4.599
Speed: 5.171
Speed: 5.853
Speed: 6.685
Speed: 7.361
Speed: 8.013
Speed: 8.421
Speed: 9.251
Speed: 10.503
Speed: 11.848
Speed: 14.153

TPE
Time Stamp:

Comments
Offsets

2006-234 00:00

Motion sensing unit to the transducer 1

X Head 1 -0.003



Y Head 1 -0.032
Z Head 1 0.631
Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000
Navigation antenna to the transducer 1
X Head 1 -0.947
Y Head 1 3.288
Z Head 1 3.376
Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.020

Motion sensing unit alignment errors
Gyro:1.000 Pitch:1.000 Roll:1.000

Gyro measurement error: 0.020

Roll measurement error: 0.020

Pitch measurement error: 0.020

Navigation measurement error: 0.700
Transducer timing error: 0.010

Navigation timing error: 0.001

Gyro timing error: 0.001

Heave timing error: 0.001

PitchTimingStdDev: 0.001

Roll timing error: 0.001

Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000

Tide zoning error: 0.000

Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.030
Static draft measurement error: 0.050

Delta draft measurement error: 0.010

StDev Comment: 0>,,J 1tJ@31Jp4tJ 1130 ...J.1J0A,,J°}€J° 1Ja

Svp Sensor:
Time Stamp: 2006-234 00:00
Comments
Svp #1:
Pitch Offset: 0,000

Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631



Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments (null)
Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp:

Comments

Svp #1:

Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631

Pitch Offset:
Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000

0.000

0.000

2006-248 00:00

0.000

0.000

0.000

0.000

2008-114 00:00

0.000

0.000

0.000

0.000



DeltaY: 0.000
DeltaZ: 0.000

WaterLine:

Time Stamp:

2006-234 00:00

Comments RP to WL as surveyed

Apply Yes
WaterLine 0.020

S1212 Non-Echosounder DP HIPS Vessel File
Vessel Name: 1212DPnonES.hvf
Vessel created: August 15, 2006

Depth Sensor:

Sensor Class:
Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: 0.000
Azimuth Offset:

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:
Serial Number:

Depth Sensor:

Sensor Class:
Time Stamp:

Transduer #1:
Pitch Offset:

Roll Offset: -0.060
Azimuth Offset:

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631

Manufacturer:
Model:
Serial Number:

Swath
2004-274 00:00

0.000

0.000

Odom

Swath
2006-234 00:00

0.000

0.000

Kongsberg
em3000



Navigation Sensor:
Time Stamp: 2004-274 00:00

Comments SB Xducer to Trimble
Latency 0.000

DeltaX: 0.170

DeltaY: -0.720

DeltaZ: -3.940

Manufacturer:
Model:
Serial Number:

Time Stamp: 2006-234 00:00

Comments RP to IMU
Latency 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POS/MV4
Serial Number: (null)

Gyro Sensor:

Time Stamp: 2004-274 00:00
Comments No POS

Latency 0.000

Time Stamp: 2006-234 00:00

Comments (null)
Latency 0.000

Heave Sensor:
Time Stamp: 2004-274 00:00

Comments No POS
Apply No

Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer:
Model:



Serial Number:

Time Stamp: 2006-234 00:00

Comments (null)
Apply Yes
Latency 0.000
DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Manufacturer: Applanix
Model: POS/MV4
Serial Number: (null)

Pitch Sensor:
Time Stamp: 2004-274 00:00

Comments No POS
Apply No

Latency 0.000
Pitch offset: 0.000

Manufacturer:
Model:
Serial Number:

Time Stamp: 2006-234 00:00

Comments (null)
Apply Yes
Latency 0.000
Pitch offset: 0.000

Manufacturer: Applanix
Model: POS/MV4
Serial Number: (null)

Roll Sensor:
Time Stamp: 2004-274 00:00

Comments No POS
Apply No

Latency 0.000

Roll offset: 0.000

Manufacturer:
Model:
Serial Number:



Time Stamp: 2006-234 00:00

Comments (null)

Apply Yes

Latency 0.000

Roll offset: 0.000
Manufacturer: Applanix
Model: POS/MV4
Serial Number: (null)

Draft Sensor:

Time Stamp: 2004-274 00:00
Apply No

Comments

Entry 1) Draft: 0.000 Speed: 3.100
Entry 2) Draft: 0.045 Speed: 4.900
Entry 3) Draft: 0.099 Speed: 5.499
Entry 4) Draft: 0.149 Speed: 6.300
Entry 5) Draft: 0.128 Speed: 7.000
Entry 6) Draft: 0.117 Speed: 7.600
Entry 7) Draft: 0.098 Speed: 8.100
Entry 8) Draft: 0.091 Speed: 8.300
Entry 9) Draft: 0.079 Speed: 8.701
Entry 10) Draft: 0.043 Speed: 9.400
Entry 11) Draft: 0.029 Speed: 10.100
Entry 12) Draft: 0.025 Speed: 10.800

Entry 13) Draft: -0.023 Speed: 11.799
Entry 14) Draft: -0.063 Speed: 12.899
Entry 15) Draft: -0.058 Speed: 13.799
Entry 16) Draft: -0.073 Speed: 15.001
Entry 17) Draft: -0.044 Speed: 15.800

Time Stamp: 2006-234 00:00
Apply No

Comments (null)

Entry 1) Draft: 0.000 Speed: 4.599
Entry 2) Draft: -0.003 Speed: 5.171
Entry 3) Draft: 0.029 Speed: 5.853
Entry 4) Draft: 0.028 Speed: 6.685
Entry 5) Draft: 0.044 Speed: 7.361
Entry 6) Draft: 0.014 Speed: 8.013
Entry 7) Draft: 0.032 Speed: 8.421
Entry 8) Draft: -0.013 Speed: 9.251
Entry 9) Draft: -0.064 Speed: 10.503

Entry 10) Draft: -0.048 Speed: 11.848
Entry 11) Draft: -0.140 Speed: 14.153

TPE

Time Stamp: 2006-234 00:00



Comments
Offsets

Motion sensing unit to the transducer 1
X Head 1 -0.003
Y Head 1 -0.032
Z Head 1 0.631

Motion sensing unit to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Navigation antenna to the transducer 1
X Head 1-0.947
Y Head 1 3.288
Z Head 13.376

Navigation antenna to the transducer 2
X Head 2 0.000
Y Head 2 0.000
Z Head 2 0.000

Roll offset of transducer number 1 0.000
Roll offset of transducer number 2 0.000

Heave Error: 0.050 or 5.000" of heave amplitude.
Measurement errors: 0.020

Motion sensing unit alignment errors
Gyro:1.000 Pitch:1.000 Roll:1.000

Gyro measurement error: 0.020

Roll measurement error: 0.020

Pitch measurement error: 0.020

Navigation measurement error: 0.700
Transducer timing error: 0.010

Navigation timing error: 0.001

Gyro timing error: 0.001

Heave timing error: 0.001

PitchTimingStdDev: 0.001

Roll timing error: 0.001

Sound Velocity speed measurement error: 0.000
Surface sound speed measurement error: 0.000
Tide measurement error: 0.000

Tide zoning error: 0.000

Speed over ground measurement error: 0.030
Dynamic loading measurement error: 0.030
Static draft measurement error: 0.050

Delta draft measurement error: 0.010

Svp Sensor:
Time Stamp: 2004-274 00:00
Comments
Svp #1:
Pitch Offset: 0,000

Roll Offset: 0.000



Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

Time Stamp: 2006-234 00:00
Comments

Svp #1:

Pitch Offset: 0.000

Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: -0.003
DeltaY: -0.032
DeltaZ: 0.631

Pitch Offset: 0.000
Roll Offset: 0.000
Azimuth Offset: 0.000

DeltaX: 0.000
DeltaY: 0.000
DeltaZ: 0.000

WaterLine:
Time Stamp: 2004-274 00:00
Comments SB Xducer to WL
Apply No

WaterLine -0.400
Time Stamp: 2006-234 00:00
Comments RP to WL as surveyed

Apply No
WaterLine 0.022




CARIS Offset Sign Conventions

» X+

Y+ <

Z+




APPENDIX IV

Calibration Reports



D B

Jun 27, 2007 DIGIBAR CALIBRATION REPORT
' version 10 (o) 2004

Seﬁa’ # ODOM HYDROGRAPHIC SYSTEMS Inc

98314-062707

Burn these numbers to EPROM: Gradient 3402
Intercept 513

Calibration Graph

2.00

1.00

[ VR

OBSERVED-CALCULATED (METERS)

-1.00
-2.00
TEMPERATURE (CENTIGRADE)
Odom Hydrographic Systems, Inc.
1450 SeaBoard Avenue Baton Rouge Lowsiana 708106261 USA
Telephone (225).768-3051 Facsimile (225)-766-5122
a’g E-mail email@odomhydrographic com HTTP www adomhydragraphic com




Date:

Serial #:

98314-062707

Jun 27, 2007

ODOM HYDROGRAPHIC SYSTEMS Inc

DIGIBAR CALIBRATION REPORT

varsion 10 i) 2004

STANDARD DEL GROSSO H?0

TEMP VELOCITY MEASURED RES_VEL

4.00
450
500
5.50
6.00
650
7.00
7.50
800
8.50
9.00
9.50
10.00
10.50
11.00
11.50
12.00
1250
13.00
13.50
1400
14.50
15.00
1550
16.00
16.50
17.00

0.20
0.10
0.00
-0.10 @
-0.20

1421 62
142390
142615
1428 38
1430.58
143275
1434 90
1437 02
143912
144118
144323
144525
1447 25
144922
145117
1453.09
1454 99
1456 B7
1458.72
1460.55
1462.36
146414
1465.81

1467 85
1469.36
147108
147273

FREQUENCY

554173
5550.68
5558.57
5566 72
5575.58
5583 61
5591 60
5589.85
5607 40
561545
562310
5630 64
5638 15
5645 48
5652 71
5659 90
5667.23
5674 26
5681 06
5688.13
5694 71
5701.43
5708.11
5715.05
572144
572771
5733.93

142155
1423983
142603
142821
1430.55
143268
1434 81
1437 00
1439.00
1441 14
144318
144518
1447 18
144913
145105
1452 96
1454 91
1456 77
1458 58
1460.46
1462.21
1464 00
146577
1467 62
1469 31
147098
147263

OBS-CAL

-007
003
-013
017
-0.03
007
009
-0.02
-0 11
-0 04
-0.06
-0.07
-0.07
010
-012
014
-0.08
-0.10
-0.14
-0.09
-018
-0.15
-0.14
-0.03
-0058
-008
010

17.50
18 00
18 .50
19.00
19.50
2000
2050
2100
2150
22.00
22,50
2300
2350
2400
24 50
2500
25.50
2600
26 50
2700
27 50
2800
28.50
29.00
29.50
30.00

TEMP VELOCITY

1474 38
1476.01
1477 62
1479.21
1480.77
1482 32
1483 84
148535
1486 83
1488 29
148974
149116
1492 56
1493 85
149532
1496 66
1497 99
1499 30
1500 59
1501.86
1503 11
1504 .35
1505 56
1506 76
1507 94
1509.10

5740.30
5746 29
5752 42
5758.57
576427
5770 51
5776 30
5781 91
5787 47
5793 04
5798 61
5803 87
5809.27
5814 28
5819.90
582460
5829 64
5834 63
5839.28
5844 22
5848 69
5853 44
5857 79
5862 22
5866 58
5870.89

147433
1475 92
1477 56
147918
148070
148236
1483 89
1485.38
1486.86
1488.34
148982
149122
1492 66
1493 99
1495 48
1498.73
1498 07
1499 40
150063
1501.95
1503.13
1504 40
1505 55
1506 73
1507 89
150903

¥

MEASURED RES_VEL
FREQUENCY

OBS-CAL

-0.05
-009
-007
-0.02
-0.07
004
0.05
004
003
005
0.09
0.08
0.08
0.04
017
0.07
0.08
010
0.05
0.09
002
0.05
-0.01
-003
-0.05
-007

Odom Hydrographic Systems, Inc.
1450 SeaBoard Avanue Baton Rouge Lowsiana 70810-8261 USA
Telephone (225)-769-3051 Facsimile (225)-766-5122

E-mail smail@odomhydrographic com HTTP www odomhydroaraphic com




Date:

Date: e DIGIBAR CALIBRATION REPORT
' version 10 (c) 2004

Serial #: ODOM HYDROGRAPHIC SYSTEMS, Inc

SN:dbp102204

Burn these numbers to EPROM: Gradient 3370
Intercept 381

Calibration Graph

200 r

1.00

00 | \_—" T

OBSERVED-CALCULATED (METERS)

-1.00
-2.00 -
TEMPERATURE (CENTIGRADE)
Odom Hydrographic Systems, Inc. .
1450 SeaBoard Avenue, Baton Rouge. Louwsiana TOB10-6261 USA
Telephone: (225)-769-3051. Facsimile (225)-766-5122
m’. E-mail email@odomhydrographic com. HTTP www odomhydrographic com




Date: DIGIBAR CALIBRATION REPORT N

Oct 22, 2004

version 1.0 (c) 2004

Serial #: ODOM HYDROGRAPHIC SYSTEMS, Inc
SN:98314-102204

STANDARD DEL GROSSO H?0 -. .
TEMP VELOCITY MEASURED RES_VEL OBS-CAL TEMP VELOCITY MEASURED RES_VEL OBS-CAL
FREQUENCY FREQUENCY
4.00 142162 5545.09 1421.59 -0.03 17.50 1474 38 574558 1474 37 -0.01
4.50 142390 5553.21 142373 -0.17 18.00 1476 01 575178 1476.00 -0.01
5.00 142615 5562.38 1426 14 0.0 18 50 1477 62 5757 86 1477 60 -002
5.50 1428.38 557091 1428 39 o00;m 18.00 147921 5764 34 1479 30 010
6.00 1430.58 5579.53 1430.66 0.08 18.50 1480 77 577012 1480 83 006
6.50 143275 5588.00 143289 0.13 20.00 1482 32 577598 1482 37 008
7.00 1434 90 5596.06 143501 01 20.50 1483 B4 5781.85 1483.91 0.07
7.50 1437.02 5604 .02 1437.10 0.08 2100 148535 5787 34 1485 36 001
8.00 1439.12 5611.94 143919 L 007 21.50 1486 83 579317 1486 89 006
8.50 1441.19 5619.58 1441.20 0.01 22.00 1488 29 5799 14 1488 47 017
9.00 1443.23 5627 43 1443.26 003 22,50 148974 5804 33 1489 83 010
950 1445 25 5634 92 144524 -0.02 23.00 1491 16 581000 1491 32 016
10.00 1447 25 564237 1447.20 -0.05 23.50 1492 56 5814 68 1492 56 <00
10.50 144922 5650.22 1449 26 0.04 2400 1493 95 5820 10 1493 98 003
11.00 145117 5657 46 145117 0.00 2450 149532 582513 1495 31 -0.01
11.50 1453.09 5664.53 1453.03 -0.06 2500 1496 66 583051 1496 72 0.06
12.00 1454 99 567206 1455.01 0.02 2550 1497 99 583576 1498 11 012
12.50 1456 87 5679.17 1456.88 0.01 26.00 1499 30 584028 149929 000
13.00 145872 568617 1458.73 0.00 26 50 1500 59 5845 08 1500 56 -0.03
13.50 1460.55 5693.38 1460.63 0.07 27 .00 1501 86 5850 08 1501 B8 ao2
14.00 1462 36 5700.23 1462 43 0.07 27 .50 1503.11 5854 64 1503 08 -0.04
14.50 146414 5707 22 1464 27 012 28.00 1504 35 5859 13 1504 26 -009
15.00 1465.91 571365 1465.96 005 28.50 1505.56 5863 76 1505 48 -0.09
15.50 1467.65 572003 1467 64 0.00 29.00 1506.76 5868 60 1506.75 -0.01
16.00 1469,36 5726.56 1469 36 000 29.50 1507 .94 587284 1507 87 -0.07
16.50 1471.06 5732.97 1471.05 -0.01 30.00 1509 10 5877 42 1509 07 -003
17.00 147273 5739 40 1472.74 0.01
0.20

0.10
0.00
-0.10
-0.20

Odom Hydrographic Systems, Inc.
1450 SeaBoard Avenue, Baton Rouge. Lowsiana 70810-6261 USA
Telephone (225)-768-3051. Facsimile (225)-766-5122
&v E-mail emaili@odomhydrographic com. HTTP www cdomhydrographic com




Sea-Bird Electronics, Inc. Phene: (425) 643-9866
1808 136th Place NE Fax: (425) 643-9854

m Bellevue, WA 98005 E-mail: seabird @ seabird.com
USA Web: www.seabird.com
APPLICATION NOTE NO. 42 Revised September 2001

ITS-90 TEMPERATURE SCALE

Beginning Junuary 1993, Scu-Bird wmperature calibration certificates list a new set of coctiicients labeled g, #1. ¢, J,
and FB. These coefficients cormespond to 1TS90 (T90} wemperatures and should be entered by those rescarchers
working with SEASOFT-DOS Versions 4208 and higher (and ull versions of SEASOFT-Win32). For the
convenience of users who preter to use older SEASOFT versions, the new certiticates also list a, b, ¢, &, and FO
coefficients comresponding w IPTS68 (T68) temperatures as required by SEASOFT-DOS versions older than 4,208,

It is important to note thar the international oceanographic research community will continue to use T68 for
compulation of salinity and othcr scawater propertics. Theretore, following the recommendations of Saunders {1990)
and as supported by the Joint Panel on Cecanographic Tables and Standards (19613, SEASOFT-DOS 4.200 and
later and all versions of SEASOFT-Win32 convert between TO8 und T90 uccording to the linear relationship:

Tag = 100024 * Ty

The use of T68 for salinity and other seavater calcalations is automatic in atll SEASOFT programs. However, when
sclecting temperature as a display/output variable, you will be prompted to specify which standard {T90 or T68) is
1o be used to compute temperature. SEASOFT recognizes whether you have entered T90 or T68 coeflicients in the
configuration (.con) file, and computes TYO temperature directly or culeulates it from the Saunders linear
approximation, depending on which cocfticients were used and which display variable type is sclected.

For example, it g, 4, 4, j, FO coefficients (T9(}) are entered in the .con file and you select temperature varioble lype as
T8, SEASOFT computes T90 temperature directly and multiplies it by 1.00024 to displuy To8. Conversely, if a, b,
¢, d, and IO coefficients (T68) are entered in the .con file and you select temperature variable type as TO(.
SEASOFT computes T68 directly and divides by 1.00024 1o display T90.

Note: The CTD configuration (.con) file is edited using the Configure menu {in SEASAVE or SBE Duta Processing
in our SEASOFT-Win32 suite of programs) or SEACON (in SEASOFT-DOS).

Also beginning January 1995, Sea-Bird's own temperatiure metrology laboratory (based upon water triple-point and
gallium melt cell, SPRT, and ASL F18 Temperature Bridge) converted 1o 790, These T90 standards are now
employed in calibruting «f Sea-Bird temperature sensors, und as the reference temperature used in conductivity
calibrations. Accordingly, all culibration certiticates show T90 (g, h, i, j) coefticients that result directly from
T90 standards, and T6R coefficients (4, b, ¢. d) computed using the Saunders linear approximation.



1808 126" Place NE, Bellevue, Washington 98005 USA Tel{425)543-9868
Website: http:/iwww.seabird.com Email: seabird@seabird.com

s = E Sea-Bird Electronics, Inc. FAX: (425) 643-9954
RRARARALZ

Service Report

SBE Job Number: 42655 Date: 19, Apnl 2006

Customer: ) Atlantic Marine Cenicr

Customer ldentified Problem:
i Calibrate SBE 19 SEACAT Profiler, S/N 1913768-2039,

Services Performed:

le Calibrations and services performed on SBE 19 SEACAT Profiler. $/N 1913768-2039.
Posl calibrated the temperature and conductivity sensors.
Calibrated the pressure sensor,
Performed full diagnostic evaluation.



Residual, {(Degrees C}

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 3868 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 2039
CALIBRATION DATE: 07-Apr-06

COEFFICIENTS

L'1'S-90
a

£0 = 1050

BATH TEMP INSTRUMENT FREOQ

(I1S-90) (Hz)

1.080%8 2426.891

il i
3252.245
e 3538.443
2 3951.072
29,3030 1354.3€3
37,5000 4632.158

SBEI9 TEMPLRATURE CALIBRATION DATA
L1S-90 TEMPRATURE SCALE

[TS-68 COEFFICIENTS

a = 3.84763453e-00%
b =
q =
£3
INST TEMP RESIDUAL
{75-90) (1TS-90)
1.¢000 0.00003
4, 4098 ( 03
15.
18.
23,9930
23.0001
37,4904 =0.,0000h

Temperature 1TS-90 = 1/{g 4 h[ln(fo-"f)] + i[inz(fuf‘{')] +j[h13(f0/f)]} -273.15(°C)

ﬁmpﬂmmcH368:IHa+bUm%m]+dM%%@]me%%ﬂnfEﬂJSFC)

Following the recommendation ol JPOTS: T”‘ is assumed to be 1.00024 * 'l"m (-21035°C)

Residual = instrunient temperature - bath lemperature

Date, Offset(mdeg C)

.02 '@ 07-Jan05 0.54

A ] 07-Apr-06 -0.00
.1

; ® ;
0004 T2y : ol -2 2
-0.01
P 7 I G O O A B
-5 0 & 10 15 20 25 30 35
Temperature, Degrees C
POST CRUISE

CALIBRATION




S B E SEA-BIRD ELECTRONICS, INC.
1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
m Phone: (425) 643-9866 Fax: (425} 643-9954 www.seabird.com

Temperature Calibration Report

Customer: __ |[Atlantic Marine Center |

Job Number: J 42655 _] [Date of Report: “ 4/7/2006 ]

Model Numhﬂl SBE 19 lSeriaI Number: Jr 1913768-2039
Temperature sensors are gormaily calibrated *us received', without udj alfowing a deterswination sensor drift. {f

the calibration identifies @ probiem, then a second calibration is performed after work is completed. The 'as received'
calibration is not performed if the sensor is damaged or non-functional, or by customer regiest.

An ‘as received’ calibration certificate is provided, listing coefficients to cotvert sensor, frequency fo lemperature. Users
must clioase whether the 'as received’ calibration ur the previous calibration befter represcnis tire seasor condition
during deplevinent, In SEASOFT enter the chosen cocfficients using the program SEACON. The coefficient “uffset’
altows a smalf corvection for drift between calibrations (consult the SEASOFT manuai). Calibration coefficients
obtuiited after a repair apply aniy to subsequent duta.

'A% RECEIVED CALIBRATION' v Performed Not Performed
Date: | 4/7/2006 Drift since last cal: -.00044 Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR! Performed ¥ Not Performed

Date: I:] Drift since Last cal: L—___l Degrees Celsius/year

Comments:



Residual, {S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phane: (425) 643 - 9866 Fax (425) 643 - §954 Email seabird@seabird. com

SENSOR SERIAL NUMBFR: 2039 SBE19 CONDUCTIVITY CALIBRATION DATA
CALIBRATION DATE: 07-Apr-06 PSS 1978 C(35,13,0) = 42914 Seimens/meter
GHI) COREFFICIENTS ABCDM COUFFICIENTS
-3.G135083221000 a = 4.843538493e-002
4} 4. 702 b = 4.1B6Z2£5422-001
fes =3 L2TE9E66
& -1.4142021

imominsl:} m Fraih

irominasl = =% .573Ce-003 incmiznal]

BATI TEMP BATH SAL BATHCOND  INST FREQ INST COND RESIDUAL

{I1S-90} (PSU) (Siemens/m} {kllz) (Siemens/m) (Siemens/m)
22,0002 0.0000 0.05000 2.BER3D C.oooas 0.0000¢
1.00C0 34,8489 2.58620 £.403541 2 =G 00501
4.43%99 e 2.729437 8.77583 3 JC3
14.96599 34. 4.27936 4. -0.0C001
18,2800 38877 4.62566 4. -0.00002
21.999% 3.8 3 5, -C.0oe03
24,0000 34. B 11.27287 5. 0.030011
F2LEDRD 34,86 .5 11.60%67 5. =0, 00006

Conduetivily = (g + hf2 + if3 : jt‘i) A10¢1 = &1 - ep) Siemens/meter

Conduclivity = (a[‘m . bf: +¢+dt)/ [10 (1 +ep) Siemens/meter

t — temperature[°C)]: p = pressure[decibars|; & = CTeor: £ ~ CPeor;

Residual = (instrument conductivity - bath conductivity) using g. h, 1, j cocfficients

Date, Slope Correclion

<l e R T T B v ® | 07-Jan-05 0.9997617

- A | 07-Apr-06 1.0000000

£
0.001 |-—— e Y
.
-
L

e
0000 - - P 1 . E s & E Y A n
-0.001- : S — S—
0002 b Lol | | b

0 1 2 3 4 5 6 7

Conductivity (Siemens/mj}
POST CRUISE
CALIBRATION




s B SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

[Customer: ][Atlantic Marine Center |
Job Number: |[ 42855 | [Date of Report: || 4/7/2008 |
Model Number:|[  SBE19 | Serial Number: || 1913768-2039 |

Conductivity sensors qre normally calibrated ‘s received', without cleaning or adjnsiments, allowing a determination of
semsor drift. 1f the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is compicted. The 'as received calibration is not performed if the seusor is damaged or non-
functionai, or by custamer request.

A 'as received' calibration certificate is provided, listing the coefficients wved to convert sensor frequency 1o
conrductivity. Users must choose wiether the a3 received” calibration or the previoas calibration better represents the
sensor condition during deplovment. In SEASOFT enter the chosen coefficients using the program SEACON. The
coefficient 'slepe’ allows smell corrections for drift between calibrations (consuli the SEASOFT manual). Calibration
coefficients obtained after a repair or cleaning apply only 10 subsequent data.

‘AS RECEIVED CALIBRATION' v Performed Not Performed
Date: Drift since last cal: PSU/month*
Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' Performed ¥ Not Performed
Date: [:I Drift since Last cal: I: PSU/month*
Comments:

*Measured a2 3.0 8/m

Lol cleaning and electrode replutinizing tend to ‘resct’ the conductivity sensor to ity original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stabitity of the sensor circuit,



Residual, {% FSR)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax {425} 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 2039
CALIBRATION DATE: 10-Apr-06

QUADRATIC COLEFTICIENTS:

SBEI9 PRESSURE CALIBRATION DATA
300 psia S/N 123248 TCV: 489

STRAIGHT LINE FIT:

PAO = 1.484621e+002 M = -3.905568e-002
PAl = -3.905807e-002 B = 1.486022e+002
PA2 = 2.420046e-008
PRESSURE INST COMPUTED  ERROR LINLAR LRROR
PSIA OUTPUTI{N) PSIA YoFS PSIA YakS
14.54 3437.0 14.51 -0.01 14 .37 -0.086
59.67 2281.0 59.50 -0.06 5%.52 =08
119.68 743.0 119.46 -C¢.07 g 58 -0.03
LTS IET -795.0 179.53 -0.05 175.65 -0.01
235.67 2328.0 238.56 -0.03 238,58 -0.04
293,66 -3860.0 295.60 -0.02 299.36 -0.10
235.66 -2335.0 239.84 0.06 239.84 0.06
179.65 -804.0 175.88 0.08 1B0.00 0.12
119.65 735.0 115.77 0.04 118.90 0.08
59.66 2274 .0 59.77 0.04 58,79 0.04
14.54 3434.0 14 .63 0.03 14.48 -0.02
Straight Line Fit:
Pressure (psia) — M * N + B (N — binary output)
Quadratic Fit;
pressurc {psia) = PAO+ PA1 * N + PA2* N
Residual = {instrument pressure - true pressure) * 100/ Full Scale Range
Date, Avg Delta P %FS
U2 ' i/ | ® | 10-Apr-06 000
0.25-=mn -
- ..
® [ ] L]
0.00 s S S
. .
. .
L]
S0.25 e e e e e o
70_50\{{\\\JIIIIIIiII,\IIIIII\J_J
0 50 100 150 200 250 300

Pressure (PSIA)



s B E SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RARRRALRL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

[Customer:  |[NOAA / NRT3 Pier 7, port of Tacoma
[Job Number: || 46660 | [Date of Report: || 5/8/2007
[Model Number || SBE 19 | [Serial Number: || 1913768-2039

Temperature sensors are normally calibrated 'as received’, with dljust; s, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The ‘as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An ‘as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received’ calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient "offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: | 5/8/2007 Drift since last cal: -0.00023 Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' Performed ¥ Not Performed

Date: :l Drift since Last cal: |:| Degrees Celsius/year

Comments:



S B SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
(RRRRAZLRLL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report
[Customer:  ||[NOAA / NRT3 Pier 7, port of Tacoma |

|J0|J Number: || 46660 | |Date of Report: ” 5/8/2007 |
|Mode] Number ” SBE 19 I |Serial Number: ” 1913768-2039 |
Conductivity sensors are normally calibrated ‘as received', without cleaning or adj allowing a determination of

sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The ‘as received' calibration is not performed if the sensor is damaged or non-
Sunctional, or by customer request.

An ‘as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to
conductivity. Users must choose whether the ‘as received’ calibration or the previous calibration better represents the
sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON, The
coefficient 'slope’ allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration
coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: | 5/8/2007 Drift since last cal: -0.00030 PSU/month*
Comments:
'CALIBRATION AFTER CLEANING & REPLATINIZING' Performed ¥ Not Performed
Date: :l Drift since Last cal: |:| PSU/month*
Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to ‘reset’ the conductivity sensor to its original condition. Lack af drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SBE19 CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Seimens/meter

SENSOR SERIAL NUMBER: 2039
CALIBRATION DATE: 08-May-07

ABCDM COEFFICIENTS

a = 4.82130545e-002
4.18964246e-001
3.93262169e+000
-1.21007322e-004

GHILJ COEFFICIENTS

g = =3.94753303e+000
= .70963940e-001

= 1.19052102e-003

i = -3.0404511%e-005 d =

Residual, (S/m)

= =9,5700=-008 (nominal) 2.1

= 3,2500e-0068 (nominal) yr = =9,5700e-008 (nominal}
BATH TEMP BATH SAL BATH COND INST FREO INST COND RESIDUAL
{ITS-90) (PSU) (Siemens/m) (kHz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2.88541 0.00000 0.00000
L0000 34,7715 2 8.38604 2 =0.00000
4.5487 34.7514 8.76258 3 =0.00000
#9999 34.7091 9.85026 4 E 0.00000
.4959 34.7001 10.20640 4.60461 0.00001
.9989 34.6903 S 10.756%94 5:16193 -0.00001
29.0000 34.6850 i 2 11.24731 5.68323 =0.00000
2.5000 34.6817 6.05517 11.58439 6.05517 0.00000

Conductivity = (g +hf” +if” +j£ ") /10(1 + 5t + £p) Siemens/meter

Conductivity = (af ™ +bf” + ¢ +dt) / [10 (1 +ep) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; § = CTcor; € = CPeor;

Residual = (instrument conductivity - bath conductivity) using g, h, i, j coeflicients

Date, Slope Correction

bioge 07-Apr-06 0.9998797
08-May-07 1.0000000

0.001

__,_._._.—-""”4 .__—_.f—-“f
.—-—'—'_'_.j._'_

0.000 & A

-0.001

-0.002 L1 11 111 L1111 1 T | L1 11 | |

0 2 3 4 5 6 7

Conductivity (Siemens/m)



Residual, (% FSR)

SEA-BIRD ELECTRONICS, INC.
1808 136th Place N.E., Bellevue, Washington, 98005 USA

Phone: (425) 643 - 9866 Fax (425) 64

SENSOR SERIAL NUMBER: 2039
CALIBRATION DATE: 08-May-07

QUADRATIC COEFFICIENTS:
PAQ = 1.482382e+4002
PAl = -3.904937e-002
PA2 = 2.654662e-008

PRESSURE INST COMPUTED ERROR

PSIA OUTPUT(N) PSIA %FS
14.57 3433.0 14.49 -0.02
59.88 2268.0 59.81 -0.02

731.0 119,71 -0.05
-807.0 179.%7 -0.03

y: v -2341.0 239.80 -0.02

299 .86 -3872.0 299 .84 -0.01

239.87 -2345.0 239.95 0.03

179.87 -814.0 150.04 0.06

.0 119.94 0.02
Y] 60.01 0.03
0 14.65 0.03

Straight Line Fit:

Pressure (psia) =M * N + B (N = hinary output)
Quadratic Fit:

pressure (psia) = PAO + PA1 * N + PA2 * N2

3 - 9954 Email: seabird@seabird.com

SBE19 PRESSURE CALIBRATION DATA
300 psia S/N 133248 TCV: 489

STRAIGHT LINE FIT:
3.904727e-002
B = 1.483877e+002

M=

Residual = (instrument pressure - true pressure) * 100 / Full Scale Range

Date, Avg Delta P %FS

0.50 [®@] 08-May-07 0.00
0.25
0.00 o ———0——____F-—F"Hh_'"“‘“———o-n
; —1— —
[t
S Yo A T T T T T T O Y
0 50 100 150 200 250 300

Pressure (PSIA)



Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 2039 SBE19 TEMPERATURE CALIBRATION DATA
CALIBRATION DATE: 08-May-07 ITS-90 TEMPRATURE SCALE

ITS-90 COEFFICIENTS
g = 4.17042034e-003

h = 5.93802538=-004

i = 2.76765585e-006

i = =2.136079462-006

£0 = 1000.0

BATH TEMP INSTRUMENT FREO
{ITS-90) {Hz)
1.0000
4.5487
14.
18.
23.

29
32.5000

Temperature ITS-90 = 1/{g + hiin(f /5] + ilfu:(fufﬂi + jun"(fum 1} - 273.15 (°C)
Temperatare ITS-68 = 1/(a + bln(f,/0)] + clin’(1,/0] + dlin’ (£ )]} - 273.15 (°C)
Following the recommendation of JPOTS: T“ is assumed to be 1.00024 * qu {-210 35 °C)
Residual = instrument temperature - bath temperature

Date, Offset(mdeg C)

0.02 07-Apr-06  0.25
08-May-07 -0.00

0.01

g

0.00 A R +—21T%

-0.01

_0_021I|I||||I||||1II||||II|I||||I|1|

5 0 5 10 15 20 25 30 35

Temperature, Degrees C



S B SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RARRRRALREL phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Customer Information:
Company NOAA / NRT3 Pier 7, port of Tacoma

Contact Kurt Mueller
PO Number TBED

RMA Number | 49199 |

Date 1/30/2008

Serial Number || 19P44126-4778

Model Number ||SBE 19Plus |

Services Requested:

1. Evaluate/Repair Instrumentation.
2, Perform Routine Calibration Service.

Problems Found:

Services Performed:
1. Performed initial diagnostic evaluation.

2. Performed "Post Cruise" calibration of the temperature & conductivity sensors.

3. Calibrated the pressure sensor.

4. Performed complete system check and full diagnostic evaluation.

Special Notes:

Wednesday, January 30, 2008

Page 2 of 2



S B SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RARRRRALREL phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

I ez :
Customer Information:
Company NOAA / NRT3 Pier 7, port of Tacoma

Contact Kurt Mueller
PO Number TBED

RMA Number | 49199 |

Date 1/30/2008

Serial Number | |05M0853

Model Number || SBE 05MT |

Services Requested:
1. Evaluate/Repair Instrumentation.

Problems Found:

Services Performed:
1. Performed initial diagnostic evaluation.

Special Notes:

Wednesday, January 30, 2008

Page 1 of 2



s B E SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RARRRALRL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

[Customer:  |[NOAA / NRT3 Pier 7, port of Tacoma
|J0h Number: || 49199 | |Date of Report: ” 1/15/2008
[Model Number || SBE 19Plus | [Serial Number: || 19P44126-4778

" n ie alll

Temperature sensors are normally calibrated 'as received’, ing a determination sensor drift.
If the calibration identifies a problem, then a second calibration is performed after work is completed. The ‘as received’
calibration is not performed if the sensor is damaged or non-functional, or by request.

An ‘as received’ calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the "as received’ calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient "offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: | 1/15/2008 Drift since last cal: +0.00050 | Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' Performed ¥ Not Performed

Date: :l Drift since Last cal: |:| Degrees Celsius/year

Comments:



S B SEA-BIRD ELECTRONICS, INC.

1808 - 136th Place Northeast, Bellevue, Washington 98005 USA
RARRRAZLRLL) phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

[Customer:  ||[NOAA / NRT3 Pier 7, port of Tacoma

|J0|J Number: || 49199 | |Date of Report: “ 1/15/2008
|Model Number ” SBE 19Plus I |Seria1 Number: ” 19P44126-4778
Conductivity sensors are normally calibrated ‘as received', without cleaning or adj Howing a determination of

sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The ‘as received’ calibration is not performed if the sensor is damaged or non-
Sunctional, or by customer request.

An ‘as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to
conductivity. Users must choose whether the ‘as received’ calibration or the previous calibration better represents the
sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON, The
coefficient ‘slope’ allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration
coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: | 1/15/2008 Drift since last cal: +0.00020 PSU/month
Comments:
'CALIBRATION AFTER CLEANING & REPLATINIZING' Performed ¥ Not Performed
Date: :l Drift since Last cal: |:| PSU/month
Comments:

“Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to ‘reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4778
CALIBRATION DATE: 15-Jan-08

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.024672e+000 CPcor = -9.5700e-008
h = 1.567020e-001 CTcor = 3.2500e-006
1 = -5,292530e-004
i = 6.413526e-005
BATHTEMP  BATHSAL BATHCOND INST FREO INST COND RESIDUAL
{ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 g.0000 0.00000
0.9998 34.6999 2.9670 0.00002
4,5000 34.6804 3.2731 -0.00002
15.0000 34.6369 4.2519 =0.00002
18.5001 34.6273 4.5960 -0.00000
24.0000 34.6158 5:1521 0.00002
29.0000 34.6074 5.6720 0.00001
32,5000 34,6005 6.0426 =0.00001
f=INST FREQ / 1000.0
Conductivity = (g +hf” +if" +j£) / (1 + 8 + £p) Siemens/meter
t = temperature[*C)]; p = pressure[decibars]; § = CTcor; £ = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.002 11-Sep-06 1.0000980
15-Jan-08 1.0000000
0.001
0.000 i i = 3 A A
———_____._‘____h‘.“\\
-0.001
-0.002 1111 L1111 1111 1111 1111 | I | 11
0 1 6 7

3 4
Conductivity (Siemens/m)



Residual, (% FSR)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4778
CALIBRATION DATE: 14-Jan-08

COEFFICIENTS:

PAQ = -3.100982e-001
BAl = 1.550723e-003
PA2 = 6,252893e-012
PTEMPAD = -7,443083e+001
PIEMPAL = 4.866190e+001
PTEMPAZ = -3.675094e-001

SBE19plus PRESSURE CALIBRATION DATA
508 psia /N 6975

PTCAO
PTCAl
PICAZ
PTICEO
PTCE1
PTICB2

= 5
= -7
= -1
= 0

.334035e+005
.084050e+000
.340383e-001
56900024001
L000000e-004
.000000e+000

PRESSURE SPAN CALIBRATION THERMAL CORRECTION
PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA  OUTPUT OUTPUT PRESSURE  %FSR ITS90 OUTPUT OUTPUT
14.64 542852.0 2.0 14.66 0.00 32.50 2.23 542968.89
211.52 €69717.8 2.0 211.54 0.00 29.00 2.16 543025.90
309.50 732789.8 2.0 309.49 -0.00 24.00 2.06 543090.51
408.01 796187.4 2.0 408.00 =0.00 18.50 1.94 543159.59
506 .39 859456.9 2.0 506.37 =0.00 15.00 1.86 543208.86
408.09 796260.2 2.0 408.12 0.01 4.50 1.64 543303.22
309.78 732996.9 2.0 309.82 0.01 1.00 i BN 543333.08
211.40 669618.7 2.0 211.38 -0.00
112.58 €05926.8 2.0 112.52 =0.01 TEMEP{ITS90) SPAN (mV')
14.63 542851.3 ) 14.686 0.01 =5.00 25.69
35.00 25.68
y = thermistor output; t = PTEMPAO + PTEMPAL * y + PTEMPAZ * y2
x = pressure output - PTCAO - PTCAL * 1 - PTCAZ * ¢
n=x*PTCBO/ (PTCBO + PTCB1 % ( + PTCB2 * )
pressure (psia) = PAO + PAL ¥ n+ PA2 # n
Date, Avg Delta P %FS
0.50+ 7 [@] 14-Jan-08 -0.00
0.25
0.00-8- t-5————— 1% . &
-0.25
oso v b b bveee v devre breee e brren
0 50 100 150 200 250 300 350 400 450 500 550

Pressure (PSIA)



Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place N.E., Bellevue, Washington, 98005 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4778
CALIBRATION DATE: 15-Jan-08

ITS-90 COEFFICIENTS
al = 1.255717e-003

INSTRUMENT
OUTPUT(n)

4.5000

15.0000
1§.5001 2
24.0000 271.651
29.0000 6589.016
32.5000 197165.778

MV = (n - 524288)/ 1.6e+007

SEE19plus TEM
ITS-90 TEMPER

INST TEMP
(ITS-90)

0.99938

.0000
.0000
5000

R = (MV *2.900e4009 + 1.024¢+008) / (2.048e+004 - MV * 2.0e+005)
Temperature ITS-90 = 1/{a0 + al [n(R)] + a2[In (R)] + a3[In (R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature

PERAT
ATURE SCALE

URE CALIBRATION DATA

RESIDUAL
(ITS-90)
=0.0000
0.0000
-0,0001
L0001
-0.0000
=0.0000
0.0000

Date, Delta T (mdeg C)

0.02 |II 11-Sep-06 -0.67
|I|15—J':‘ln—08 0.00
0.01
-0.01
-0.02 N T e I
=B 0 5 10 15 20 25 30 35

Temperature, Degrees C



CALIBRATION SHEETS

Temperature Calibration - SN 4778 . 1
Conductivity Calibration - SN 4TTE ..
Pressure Calibration - SN 4778 3

SBE 5M Configuration - S/ 050853 4

109
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Residual, (Degrees C)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place M.E., Bellevue, Washington, 98005 USA
Phone: (425) 543 - 9866 Fax (425) 643 - 9354 Email: seabird@seabird.com

SEMSOR SFRTAT. NTTRRER: 4778
CALIBRATION DATE: 10-Sep-06

ITS-00 COEFFICIENTS
all = 1.250B42e-003
al = 2.B21755e-004
a2 = -4_.4BBEBLe-009
a3 = 1.50344%9&-007
BATH TEMP
{ITS-0
1.0000
4.5000
15.0000
18.5000
24.0001
29 _ 0000
32.5001

INSTRUMENT
OUTPUT{n)

B3L225.
SEO87TL.
3FE6199.
338172,
475279,
226593,
187168,

MV = (n- S24288) § | GesDNT
Ro= (MV * 2.9000009 + 1024e+008) / {20080+ 004 - MV * 2.00+005)
Temperature ITS-90 = 1/{al+ a | [InR)] + a2[I'(R)] + a3[In(R)]} - 27315 (°C)

TaE
339
407
729
0BS5S
186
339

SEE1%nlus TEMPER ATTIRE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

Residual = instrument temperature - bath temperatune

INST

TEMP

{1ITS-90)

-oooo
.49989
.a8853
5003
.99499
.oooo
5001

0.02

0.01

0.00 - - — ™ P

-0.01

oo b b fr e r b e p bl
-5 0 5 10 15 20 25 30 35

Temperature, Degrees C

RESIDU AL
{ITS-50)
o_oooo

-0.0001

-0.0001
o.ooos

-0.o000z2
o.oooo
o_oooo

Doate, Deha T (mdeg ©)

(@] 10-Sap-06 0.00



Residual, (S/m)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place M.E., Bellevue, Washington, 98005 USA
Phone: (425) 543 - 9866 Fax (425) 643 - 9354 Email: seabird@seabird.com

SENSOR SFRTAT. NTTWMRER: 4778 SEE1%nlus CONDTCTIVITY CALTBERATION DATA
CALIBRATION DATE: 10-Sep-06 PSS 1978: C(35,15,00 = 4.2914 Siemens/meter
COEFFICTENTS:

g = -L.025110e-000 = =-8.5700e-008

h = 1.569021e-001 = 3.250D0e-00&

L = -5.943965e-004

J = 7T.001l325e-005

BATH TEMP  BATHSAL BATHCOND INST FREQ  INST COND RESTTAL

(ITS-%0 (PEL {Siemens/m) (Hz) {Siemens'm) (Siemensim)
220000 o.oooo o.poooo 2564 .77 o.oooop o.ooooo
1.0000 F4.7000 Z.96687 S063.77 Z.9670 o.ooool
4.5000 34.6799 3.27312 5253.93 3.27351 -0.00001
15.0000 34.6370 4.25194 5819.70 4.25189 -0.00001
16.5000 3462789 4.589607 6005 .66 4.5961 o.ooooo
24.0001 34.61B1 5.15240 B294.33 5.1524 -0.o0oo0n
29._0000 34.6125 5.67268 B552.44 5.6727 0.0000L
32.5001 34.608E8 604390 630,30 60439 -0.o0o00L

f= INSTFREQ / 1108080

Conductivity ={g + n if? +jf4]." {1+ &1+ ep) Siemensimener
t=temperature] *C) ) p = presure[decibars]; & = CTeorn g = CPeor,
Residual = instrument conductivity - bath conductivity

Dane, Slope Comection

0.002 [@] 10-Sep-0& 1.0000000
0.001
0.000 & ———a—F—5——————
-0.001
05 o= A T A T A A
0 1 & 7

2 3 4 5
Conductivity {Siemens/m)
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Residual, (% FSR)

SEA-BIRD ELECTRONICS, INC.

1808 136th Place M.E., Bellevue, Washington, 98005 USA
Phone: (425) 543 - 9866 Fax (425) 643 - 9354 Email: seabird@seabird.com

SENSOR SFRTAT. NTTWMRER: 4778 SEE1%nlus PRESSITRE CALTERATION DATA

CALIBRATION DATE: 22-Sep-06 508 psia SN 6975

COEFFICTENTS:

FAD = -1l.9BBE4e-001 PICAD = 5.333997e=005

FAL = 1.549568e-003 FICAL = -5.771611e=000

FAZ = 9. 04BETHe-012 PICAZ = -1.700248%&-002

FIEMFA) = -7.403048e=-001 FICED = 2.568000e=001

PTEMPAL = 4.B23344e+001 FTCBL = -2.000000e-004

PTEMPAZ = -2.462597e-001 FTCRZ = 0.000000e+000

PFRESSURE SPAN CALIBRATION THERMAL CORRECTION

PRESSURE  INST THERMISTOR (OMPUTED ERROR TEMF THERMISTOR  INST
PSIA  OUTPUT OUTPUT PRESSURE  %FSE TS9N OUTPUT OUTPUT
14.77 54282B.0 2.0 14.77 -0D.00 32.50 2.23 5428085 20
LD4.87 6010220 2.0 i04.85 -0.01 28.00 2.16 54302375
204,87 BB5452Z.0 2.0 Z04.82 -0.01 24.00 Z.05 S43057.64
F04.83 TZ9B5E.0 Z.0 304.80 -0.01 18.50 1.94 S43081.22
404 81 784178.0 2.0 404.78  -0.00 15.00 1.86 S4510B.B5
S04.78 B5B4BO0.0 2.0 S04.78  -0.00 4.50 1.64 S43178.10
404.79 784206.0 2.0 a0d. 82 o.01
F04.BL TZ9B58.0 2.0 304,083 o.o0 TEMP{IT590] SPAN {=V)
Z04.78 B6B5465.0 2.0 Z04.84 o.o01 -5.00 Z5.649
104.84 60L034.0 2.0 104.87 o.0o0 35.00 Z5.68
14.77 54283400 2.0 14.78 o.o0o0

y = thermistor output; t = PTEMPAD + PTEMPA | * y + PTEMPAZ * ¥
% = pressure oupu - PTCAD - PTCA L ¥t -PTCA2* e
n=x *PTCRBO/ (PTCBO + PTCE] Y1+ FTCE2 “11]
pressure (psia)= PAD + PAL *n +PA2+ o
Deate, Ave Dela P %FS

0.50 (@] 2Sep 06 .00

D.25

0. 00— ——— e, 4 -

-0.25

_D_SDIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
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Pressure (PSIA)



S B E Sea-Bird Electronics, Inc. FAX: (425) 643-9954
1808 136th Place ME, Bellevue, Washington 08005 USA Tel: (425) 643-9566

b, Website: htp:/Avww, seabird.com Ermail: seabind@ seabind.com

e o e e 2t e

SBE 5M MINI SUBMERSIBLE PUMP CONFIGURATION SHEET
Serial Number: 0853
Job Mumber: 44126

Customer: NOAAMGLERL
Delivery Dak:  LOAG/2006

Single Connector Housing with Titanivm screws

Pressure Case: 10,500 meters (titanium)

Maxon Motor Type:
BN 90337, Motor FN 20130 (Low power 6 VDC, 2000 RFM MAX)

B/ 20335, Motor PN 20130 (Low power 8 YDC, 2000 BEPM MAX)

Vin 15V voltage across Cz: &M VDC  Current 181 mA
VinaVvoltage acrees C2: B8 VOO Current 154 mA
VineVvoltage across C2; 570§ VDC  Current 11.3 ma

Pump submerged test, no lead, Vin 12VDC  Average cument draw in water: 123 mA

113
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PRESSURE TEST
CERTIFICATES

SBE 19plus Pressure Test Certificate - SN 4778,

SBE 5M Pressure Test Certificate - SN 0853 ...




SBE

L Vot .

e o e e 2t e

11%

Sea-Bird Electronics, Inc.

12808 136th Place ME, Bellevue, Washington 98005 USA E’:g‘_lﬁ Fﬁggﬂggﬁ
Wibsite: hitp:/fwww. seabird.com Emall: seabir i com

SBE Pressure Test Certificate

Test Date:  W25/2006  Description SBE-19 SeaCat Profiler

Job Number: 44126 Customer Name NOAA/CLERL
SBE Senzor Information: Pressure Sensor Information:
Model Number:  19P Sensor Type: Druck
Serial Number: 4778 Sensor Serial Number:  $973
Sensor Rating; S08
Pressure Test Protocol:

Low Pressure Test: 40 PSI Held For 15 Minutes
High Pressure Test: 5{H} PSI Held For 15 Minutes
Passed Test:
Tested By: PC

Hgh presure

purmrnlly suml

0 I e

dugth miing of

T Ingtry el

—_
Presurs i
! 3
/ 3
— !
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typical Teal Profla
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S B E Sea-Bird Electronics, Inc.
1208 136th Place ME, Bellevue, Washington 58005 USA Phone: (425) 643-9865

o e s FAX:  [425) 643-9854
bbb,  Website: hitpiifeww. szabird.com Email: seabird@sasbird.com

Rl gl o g el g il

SBE Pressure Test Certificate

Test Date:  T/2MW2M6  Description SBE-SM Mini-Submersible Pump

Tob Number: 44136 Customer Mame NOAA/GLERL
SBE Senzor Information: Pressure Sensor Information:
Model Number:  5M Sensor Type: None
Serial Number: (1853 Sensor Serial Number:  None

Sensor Rating; ]

Pressure Test Protocol:

Low Pressure Test: 40 PSI Held For 15 Minutes
High Pressure Test:  LKHHI PST Held For 15 Minutes
Passed Test:
Tested By: nd
Hgh presure
purmrnlly suml
0 I e
dugth miing of
T Ingtry el
—_
Pressurs !
! 3
/ }
__f !
L =
typical Teal Profla




APPENDIX V

MBES and POS-MV Calibrations

Multibeam Echosounder Calibration
Field Unit: NRT3
Date of Test: 04/23/2008
Calibrating Hydrographer(s): K. Simmons, K. Mueller, P. Sparmr

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: Kongsberg EM3000
System Location: NOAA Survey Launch 51212

Sonar Serial Number: 358
Processing Unit Serial Number: 1534

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: Fixed hull mount
Date of Current Vessel Offset Measurement / Verification:
Description of Positioning System: POS/MV version 4 w/ TrueHeave

Date of Most Recent Positioning System Calibration: 04/23/2008

TESTINFORMATION

Test Date(s) / DN(s): 04/23/2008 - DN114

System Operator(s): K. Simmons, K. Mueller, P. Sparr
Wind / Seas [ Sky: 5 knts/ <1ft/ partly cloudy

Locality: Puget Sound

Sub-Locality: Commencement Bay

Bottom Type: mud

Approximate Average Water Depth: 25m




DATA ACQUISITION INFORMATION

Line Number Heading Speed
002_1727.114 - Nav&Pitch_4knts_E 075 4
002_1730.114 - Nav&Pitch_4knts W 255 4
002_1734 114 - Nav&Pitch_8knts_E o | 075 8
001_1740.114 — Roll_4knts_1 [ 129 35
001A_ 1744114 - Roll_4knts_2 309 35
012_1755 114 - Heading_5knts_N 349 5
011_1800.114 - Heading_5knts_S 169 5
015_1803.114 - Heading_5knts N_2 349 5
012_1803 114 - Heading_5knts_S_2 169 5

TESTRESULTS

Mavigation Timing Error: 0.000

Pitch Timing Error: 0.000

Roll Timing Error: 0.000

Pitch Bias: 0.000

Roll Bias: -0.060

Heading Bias: 0.000

Resulting CARIS HIPS HVF File Name: S$1212_Simrad.hvf

NARRATIVE

Briefly and succinctly summarize the MBES Certification Test, focusing on those aspects of the test.
Particular attention shall be paid to interpretation of test results, with discussion on residual biases in
roll, pitch, heading, and navigation timing error. Any changes to configuration made based on these
results shall be described.

Errors are low and were expected to be low because the MBES sonar head is fixed-mounted directly
beneath the IMU sensor.




Multibeam Echosounder Calibration
Field Unit: NRT3
Date of Test: 09/05/2006
Calibrating Hydrographer(s): K. Simmons, J. Landsfeld, M. Foss, M. Van Waes

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: Kongsberg EM3000
System Location: NOAA Survey Launch 51212

Sonar Serial Number: 358
Processing Unit Serial Number: 1534

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: Fixed hull mount
Date of Current Vessel Offset Measurement / Verification:
Description of Positioning System: POS/MV version 4 w/ TrueHeave

Date of Most Recent Positioning System Calibration: 08/16/2006

TESTINFORMATION

Test Date(s) / DN(s): 09/05/2006 - DN248
System Operator(s): M. Foss

Wind / Seas /! Sky: calm/ <1ft/ overcast
Locality: Puget Sound

Sub-Locality: Shilshole Bay

Bottom Type: mud

Approximate Average Water Depth: 25m




DATA ACQUISITION INFORMATION

Line Number Heading}, Speed
001_1744.248 — roll 068 6
001_1748 248 — rall 248 6
002_1801.248 - heading 1 201 6
003_1803 248 -- heading 2 021 6
004_1804.248 - heading 3 201 7
002_1806 248 -- heading 4 021 6
003_1808.248 - heading 5 201 6
004_1810.248 -- heading 6 021 6
005_1814.248 - pitch (extra) 110 6
005_1816 248 - pitch (extra) 290 6
007_1822.248 - heading (wide) 021 6
008_1828.248 -- heading (wide) 201 6
002_1833.248 — roll timing 042 4

TESTRESULTS

Navigation Timing Error: 0.000

Pitch Timing Error: 0.000

Roll Timing Error: 0.000

Pitch Bias: 0.000

Roll Bias: -0.060

Heading Bias: 0.000

Resulting CARIS HIPS HVF File Name: 51212 Simrad.hvf

NARRATIVE

Briefly and succinctly summarize the MBES Certification Test, focusing on those aspects of the test.
Particular attention shall be paid to interpretation of test results, with discussion on residual biases in
roll, pitch, heading, and navigation timing error. Any changes to configuration made based on these
results shall be described

Errors are low and were expected to be low because the MBES sonar head is fixed-mounted directly
beneath the IMU sensor.




POS/MV Calibration Report

Field Unit: Navigation Response Team 3

SYSTEM INFORMA TION

Vessel: S1212

Date: 4/23/2008 Dn:
Personnel: k. Simmaons, K Mueller, P Sparr
PCS Serial # 2245
IP Address: 125.100.1 231
POS controller Yersion {Use Menu Help > About) 3.4.00
POS Version (Use Menu View > Statistics) IAW320 \erd
GPS Receivers
Primary Receiver Serial # 4435443250
Secondary Receiver Serial # So00oooTo
CALIBRATION AREA
JLocation: Tacoma, Wit D M S
Approximate Position: Lat 47 16 45
Lon -122 25 36
DGPS Beacon Station: Auta Porer

Frequency:

Satellite Constellation
Primary GPS {Port Antenna)

HDOF: 0.827
VDOP: 1.153

Sattelites in Use: 35 15,16,18,1921 22 24 25 29

|PDOP 1.405 (Usa View> GAMS Solution)

(Use View= GPS Data)

*DOPs monitored while performing calibration, stayed below 0.9

Primary GPS

12 Satellites




POS/MV CONFIGURATION

Settings
Gams Parameter Setup {Use Setti = Installation = GAMS Intallation)
User Entries. Pre-Calibration Baseline Vector
1.903 Two Antenna Separation (m) 0.000 X Component (m)
0.500 Heading Calibration Thresheld 0.000 Y Component (m)
0.000 Heading Correction 0.000 Z Component (m)

‘Configuration Notes: Two antenna separation taken from previous POSMV configuration,

POS/MV CALIBRATION

Calibration Procedure: (Refer to POS MV4 Installation and Operation Guide)

Start time: 17:30 UTC

End time: 17:34 UTC

Heading accuracy achieved for calibration: 0,050

Calibration Results:

Gams Parameter Setup {Use Settings = Ir ion = GAMS ion)
POSMV Post-Calibration Values Baseline Vector

1.901 Two Antenna Separation (m) 0.018 X Component (m)
0.500 Heading Calibration Threshold 1.900 Y Component {(m)
0.000 Heading Correction 0.019 Z Component (m)

GAMS Status Online? X

[Save Settings? X

(Calibration Notes: This is a GAMS calibration of a borrowed unit from Applanix. Criginal unit was sent to Applanix for repair.

Save POS Settings on PC {Use File > Store POS Settings on PC)
File Mame:




|GENERAL GUIDANCE

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
= The x-axis is in the fore-aft direction in the appropriate reference frame.
* The y-axis is perpendicular to the x-axis and points towards the
right {starboard) side in the appropriate reference frame.
« The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

(Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 8z about the

z-axis to align one frame with the other.

by Fitch rotation - apply a right-hand screw rotation &y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation &x about the
beice-rotated x-axis to align one frame with the other.

|SETTINGS (insert screen grabs)

Input/Output Ports (Use Settings > Input/Output Ports)

Ot
Output Select P Sup Fewre Roll Posilive Sense

= I e W (0 © Potlp (" Sturkosed Un)

et  Gansor 2 Pitch Postive Sense

* Bow Up " Stamn Up
Farmula Select

[SIMRAD 10X = Heavn Positive Sense

: F Hervalp T Heive Davn
Input Seiect
!Nﬂl'.a -I

COEETETT B3|
[com: ]cnm | cons | coma | coms |
s Patity Dats Bits: “Stap Bits Flow Cortral
5“’% =N crems || @ iEn = Moree
5600 iEwn  Hirdware
 Ogd IR T B ||~ xonsorE
Output Seject | - Rl Positive Sense
ranez2, - _F Por Lp " Starhoand Up|
[ Pitch Postin Sinse 1
= How Up ™ Stem Up
Hee Positive Sense
& Hewa Up  © Hame Down
Input Salect
Nene b.d
| Closs | P
- X
cout [COME |cows | coms | coms |
Patity Drata Bits— ~Stop Sits Flow Contral
Blaud Fate
Feo 3| FoMenn | e 2y ||| 160 Ciloas
" Even T Hardware
~ Odd FEBIs || 3B ||~ ownnsoRE







Heave Filter (Use Settings > Heave)

=

~" Heave Filter
Heave Bardwidth

5000
D ammping Ratio 0.707

=3 5]l | ’WI

[Events (Use Settings = Events)

Event 1

" Positive Edge Trigger

@ hlegative Edge Trigger

~Ewent

" Positive Edge Thgger

" Megative Edge Trigger

ime Sync (Use Settings > Time Sync)

(€2

Apply

linstallation (Use Settings > Installation)

Lever Arms & Mous Angles

Sensar Mounting | Tags, Multipth & AutaStan |

~Ref. to IMU Lever Arm————— IMU Frame w.r.t. Ref. Frame—————
®(m) [o.oo0 ® (deg) 0.000
¥im)  [oom L 0,000
2 [yooo Z (deg) 0.000
Ref to Primary GPS Lever Arm| [ Ref to Vessel Lever Arm
() 3.269 () 0.000
Wi{m) 0950 ¥ (m) 0.000
Zim 273 Z{m) 0.000
Motes: (- Ref. to Centre of Rotation Lever Arm—
g b am
wert, = With Respect To 1
e e 0.000
Frame are co-aligned (m) 0.000

= i) | e | Al View

In Navigation Mode . to change parameters go to Standby Mode |

x|




[Tags, Multipath and Auto Start {se Settings > Installation > Tags, Multipath and Auto Start)

¥ (m) [0.000
Y(m) o000
Z{m)  [o.000

X (m)
¥ (m)
Z (m)

[ Ref 13 Aux. 2 GPS Lever Arm

Lever Arms & Mounting Angles  Sensor Mounting |Tags, Multipath &Au(nSIarII
[ Ref to Aux. 1 GPS Lever Arm—

0.000
f o
[pooo

% (m) [0000
¥(m) |0.000
Z(m  [oo00

~Ref to Sensor 1 Lever Army

X (deg)
¥ (deg)
7 (deg)

~Sensor 1 Frame w.rt Ref Frame

0.000
0.000
0.000

[Ref to Sensor 2 Lever A

i Sensor 2 Frame w.rt Ref Frame

¥(mj [0.000 ¥ (deg) 0,000
Tim) |o.ooo ¥ {deg) 0.000
Z{m)  [o.0o0 Z{deg) 0.000
L Gk | O Aol iew

I Navigation Mode . ta change parameters 0o to Standby Made |

e i
Lever Arms & Mounting Angles | Sensot Mounting  Tags, Multipath & AutoStart |
~Time Tag 1 Multipath
© POS Time & Loy
 GPS Time £ vfedium
& UTC Time © Hiah
~Time Tag 2
© POS Time
© GPS Time
" UTC Time
 User Time
rAuteStart
" Disabled
= Enabled
- o (CEm] s || v |
In Navigation Mode . to change paramsters go to Standby Mode |
[Senser Mounting (Use Settings > Installation > Sensor Mounting)
]




User Parameter Accuracy (Use Settings = Installation = User Accuracy)

Frame Control (Lse Tools > Config)

I
~REMS Accuracy
Attituce (deg) |D.DSD
Heading {deg) IUEISU—
Position i) |2.DDD
Welocity (mis) IUSUU—
== e | Aaply I
GPS Receiver Configuration (lJse Settings>

Primary GPS Receiver

nstallation> GPS Receiver Configuration)

=
Primary GRS Recerver iSecnndary GPS Receiverl
~Primary GPS -GPS 1 Part
GPS Output Rate Eaud Rate
1 Hz =l | | Jesoo |
Parity rData Bits— Stop Bits—
& Mone 7 Bits « 1 Bit
Auto Configuration ~ Even
* Enabled ~ Odd ~ 8 Bits 2 Bits
" Disahled
Close | Apply
Secondary GPS Receiver
i
Primary GPS Recejver Secondary GPS Receiver |
~Secondary GPS——— | GPS2 Pont
GPS Dutput Rate Baud Rate
1 Hz =] | | [ee00 =

~Parity—— [ Data Bits— | Stop Bits—
* Mone € 7 Bits & 1 Bit
Auto Configuration———— " Even
* Enablad  Odd & 0 Dits 2 Dits
" Disabled
. Ok I Close Apply




POS/MV Calibration Report
Field Unit: Navigation Response Team 3

SYSTEM INFORMATION

Vessal: 51212

Date: 8/16/2006 Dn: 228

Personnel: K. Simmons, J.Lansdfeld, M.Foss, M. Van Waes

PCS Serial # 2245

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.10d

POS Version (Use Menu View > Statistics) MV320 Verd

GPS Receivers

Primary Receiver Serial # 60080830
Secondary Receiver Serial # 80069001

CALIBRATION AREA

Location: Seattle, WA D M 5

Approximate Position: Lat 47 42 15
Lon 122 16 9

DGPS Beacon Station: Auto Power

Fraquency:

Satellite Constellation (Use View> GPS Data)

Primary GPS (Port Antenna)

HDOP:

VDOP: *DOPs menitored while performing calibration, stayed below 0.9

Sattelites in Use:

PDOP {Use View> GAMS Solution)




POS/MV CONFIGURATION

Settings
Gams Parameter Setup {Use Setti = Installation = GAMS Intallation)
User Entries. Pre-Calibration Baseline Vector
1.903 Two Antenna Separation (m) 0 X Component (m)
0.500 Heading Calibration Thresheld 1] Y Component (m)
0.000 Heading Correction 0 Z Component (m)

‘Configuration Notes: Two antenna separation calculated from recent NGS survey.

POS/MV CALIBRATION

Calibration Procedure: (Refer to POS MV4 Installation and Operation Guide)

Start time: 15:30 UTC

End time: 15:32 UTC

Heading accuracy achieved for calibration: 0,050

Calibration Results:

Gams Parameter Setup {Use Settings = Ir ion = GAMS ion)
POSMV Post-Calibration Values Baseline Vector

1.900 Two Antenna Separation (m) 0.022 X Component (m)
0.500 Heading Calibration Threshold 1.900 Y Component {(m)
0.000 Heading Correction 0.018 Z Component (m)

GAMS Status Online? X

[Save Settings? X

(Calibration Notes: This is the first GAMS calibration conducted since system installation.

Save POS Settings on PC {Use File > Store POS Settings on PC)
File Name: POSMV_08162006.nvm




|GENERAL GUIDANCE

The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
= The x-axis is in the fore-aft direction in the appropriate reference frame.
* The y-axis is perpendicular to the x-axis and points towards the
right {starboard) side in the appropriate reference frame.
« The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence

(Apply the rotation in the following order to bring the two frames of reference
into complete alignment:

a) Heading rotation - apply a right-hand screw rotation 8z about the

z-axis to align one frame with the other.

by Fitch rotation - apply a right-hand screw rotation &y about the
once-rotated y-axis to align one frame with the other.

c) Roll rotation - apply a right-hand screw rotation &x about the
beice-rotated x-axis to align one frame with the other.

|SETTINGS (insert screen grabs)

Input/Output Ports (Use Settings > Input/Output Ports)

Ot
Output Select P Sup Fewre Roll Posilive Sense

= I e W (0 © Potlp (" Sturkosed Un)

et  Gansor 2 Pitch Postive Sense

* Bow Up " Stamn Up
Farmula Select

[SIMRAD 10X = Heavn Positive Sense

: F Hervalp T Heive Davn
Input Seiect
!Nﬂl'.a -I

COEETETT B3|
[com: ]cnm | cons | coma | coms |
s Patity Dats Bits: “Stap Bits Flow Cortral
5“’% =N crems || @ iEn = Moree
5600 iEwn  Hirdware
 Ogd IR T B ||~ xonsorE
Output Seject | - Rl Positive Sense
ranez2, - _F Por Lp " Starhoand Up|
[ Pitch Postin Sinse 1
= How Up ™ Stem Up
Hee Positive Sense
& Hewa Up  © Hame Down
Input Salect
Nene b.d
| Closs | P
- X
cout [COME |cows | coms | coms |
Patity Drata Bits— ~Stop Sits Flow Contral
Blaud Fate
Feo 3| FoMenn | e 2y ||| 160 Ciloas
" Even T Hardware
~ Odd FEBIs || 3B ||~ ownnsoRE







Heave Filter (Use Settings > Heave)

=

~" Heave Filter
Heave Bardwidth

5000
D ammping Ratio 0.707

=3 5]l | ’WI

[Events (Use Settings = Events)

Event 1

" Positive Edge Trigger

@ hlegative Edge Trigger

~Ewent

" Positive Edge Thgger

" Megative Edge Trigger

ime Sync (Use Settings > Time Sync)

(€2

Apply

linstallation (Use Settings > Installation)

Lever Arms & Mous Angles

Sensar Mounting | Tags, Multipth & AutaStan |

~Ref. to IMU Lever Arm————— IMU Frame w.r.t. Ref. Frame—————
®(m) [o.oo0 ® (deg) 0.000
¥im)  [oom L 0,000
2 [yooo Z (deg) 0.000
Ref to Primary GPS Lever Arm| [ Ref to Vessel Lever Arm
() 3.269 () 0.000
Wi{m) 0950 ¥ (m) 0.000
Zim 273 Z{m) 0.000
Motes: (- Ref. to Centre of Rotation Lever Arm—
g b am
wert, = With Respect To 1
e e 0.000
Frame are co-aligned (m) 0.000

= i) | e | Al View

In Navigation Mode . to change parameters go to Standby Mode |

x|




[Tags, Multipath and Auto Start {se Settings > Installation > Tags, Multipath and Auto Start)

¥ (m) [0.000
Y(m) o000
Z{m)  [o.000

X (m)
¥ (m)
Z (m)

[ Ref 13 Aux. 2 GPS Lever Arm

Lever Arms & Mounting Angles  Sensor Mounting |Tags, Multipath &Au(nSIarII
[ Ref to Aux. 1 GPS Lever Arm—

0.000
f o
[pooo

% (m) [0000
¥(m) |0.000
Z(m  [oo00

~Ref to Sensor 1 Lever Army

X (deg)
¥ (deg)
7 (deg)

~Sensor 1 Frame w.rt Ref Frame

0.000
0.000
0.000

[Ref to Sensor 2 Lever A

i Sensor 2 Frame w.rt Ref Frame

¥(mj [0.000 ¥ (deg) 0,000
Tim) |o.ooo ¥ {deg) 0.000
Z{m)  [o.0o0 Z{deg) 0.000
L Gk | O Aol iew

I Navigation Mode . ta change parameters 0o to Standby Made |

e i
Lever Arms & Mounting Angles | Sensot Mounting  Tags, Multipath & AutoStart |
~Time Tag 1 Multipath
© POS Time & Loy
 GPS Time £ vfedium
& UTC Time © Hiah
~Time Tag 2
© POS Time
© GPS Time
" UTC Time
 User Time
rAuteStart
" Disabled
= Enabled
- o (CEm] s || v |
In Navigation Mode . to change paramsters go to Standby Mode |
[Senser Mounting (Use Settings > Installation > Sensor Mounting)
]




User Parameter Accuracy (Use Settings = Installation = User Accuracy)

Frame Control (Lse Tools > Config)

I
~REMS Accuracy
Attituce (deg) |D.DSD
Heading {deg) IUEISU—
Position i) |2.DDD
Welocity (mis) IUSUU—
== e | Aaply I
GPS Receiver Configuration (lJse Settings>

Primary GPS Receiver

nstallation> GPS Receiver Configuration)

=
Primary GRS Recerver iSecnndary GPS Receiverl
~Primary GPS -GPS 1 Part
GPS Output Rate Eaud Rate
1 Hz =l | | Jesoo |
Parity rData Bits— Stop Bits—
& Mone 7 Bits « 1 Bit
Auto Configuration ~ Even
* Enabled ~ Odd ~ 8 Bits 2 Bits
" Disahled
Close | Apply
Secondary GPS Receiver
i
Primary GPS Recejver Secondary GPS Receiver |
~Secondary GPS——— | GPS2 Pont
GPS Dutput Rate Baud Rate
1 Hz =] | | [ee00 =

~Parity—— [ Data Bits— | Stop Bits—
* Mone € 7 Bits & 1 Bit
Auto Configuration———— " Even
* Enablad  Odd & 0 Dits 2 Dits
" Disabled
. Ok I Close Apply




